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1 Introduction

1.1 About RED SKY

The RED SKY Performance Analysis Package is a computer based tool which enables the recording and analysis of many different aspects of a farming enterprise.  It can be used for single-purpose operations such as the management of a dairy or beef unit, or it can support multi-purpose operations where several types of farming or agricultural enterprises are combined.

It can handle data for a single farm or multiple farms held by the same owner, and these may be grouped with other similar enterprises for convenient reporting where required.  

Reports are provided in a number of different formats, ranging from standard Profit & Loss Balance Sheet reports right down to per-animal profitability and pasture management reporting.  RED SKY also provides the ability to directly compare results from year to year, thus providing a true picture of development and profitability over time.

1.2 Audience

This manual is intended for:

· Farm XE "Farm Maintenance"  owners and managers

· Accountants and book keepers specialising in the management of farm accounts

· Farm XE "Farm Maintenance"  Consultancy groups overseeing the management of farming enterprises

· Any grass-roots user of the RED SKY Farm XE "Farm Maintenance"  Performance Analysis package.

1.3 Contents

This manual is intended to be a front-end user guide, to help first-time users and others find their way around the features and functions of RED SKY.

Topics include:

· Getting Started- what you need to do to install the software and get it running.

· Getting Help- how to get assistance when you need it, or even make suggestions for improvements
· Application Overview- describes the main components of RED SKY and how it works.

· The Grass Roots User Guide- sets out the features and functions and how to use them.
· ABC’s ~ Archiving, Backup and Compressing Data- gives the low-down on those vital security and housekeeping jobs.
· Glossary of Terms- a short dictionary of RED SKY jargon.
· Appendices- this is where you’ll find any absolutely unavoidable technical information.
We’ve tried to keep things simple, and we hope you’ll find this manual and RED SKY both easy to use and practical.

So let’s take the bull by the horns and get started!

2 Getting Started

2.1 System Requirements

The RED SKY Farm XE "Farm Maintenance"  Performance Analysis package requires a minimum system configuration XE "System Requirements: Minimum configuration"  of at least:

· 200Mhz CPU

· 128Mb RAM

· 20Gb Hard drive with at least 

· 12Mb of free space to download the application software.

· 150Mb of free space for the database.  Please note, however, this is a minimum- the actual space required for the database depends directly upon the amount of annual data to be stored.

· Either a 33Kb or preferably a 56Kb Internet connection.

· Any of the following operating systems: 

· MS Windows 98 SR 2,

·  MS Windows 2000,

·  MS Windows ME, 

· MS Windows NT 

· MS Windows XP.

While it may be possible to run RED SKY on a lesser configuration, we do not recommend it.  Support may not be available for a less than minimum configuration.

2.2 Installing the Software

RED SKY can be downloaded free of charge anywhere in the world, from the RED SKY website XE "Red Sky Website"  at www.redskyagri.com via the Internet.  Simply go to the Red Sky website and click on the download option you want to use.

The free download entitles you to create and use your own local copy of the application for a single farm enterprise, including entering up to two years’ worth of data: either two years of actual data or one year of actual and one year of projection data for what-if analysis.

This free copy of the software does not support 

· The full range of printed reports

· Multi-User operation

· Multiple farm definitions

· More than two years’ worth of data.

To make full use of the power of RED SKY you will need to purchase a User License and subscribe to the RED SKY Server XE “Server” .  

Alternatively, residents of Australia and New Zealand can purchase a CD version of the software online from www.fencepost.com  .

The install program is self-extracting and is managed by the RED SKY Installation Wizard which guides you step by step through the installation process.

2.3 Licenses

Purchasing User Licenses is easy.  Once you have installed RED SKY on your system, simply click on the Synchronise button of the Main Menu panel XE "Main Menu"  or use the File Menu XE "Navigation: using the File Menu"  to select the Synchronise with Server XE "Synchronisation & Licensing" 

 XE "Server"  option.  You can use either method to open the Synchronise dialog XE "Synchronisation & Licensing: synchronise dialog"  which also handles the licensing process XE "Licensing – see Synchonisation & Licensing" .

This process is described step by step in the topic Synchronisation & Licensing XE "Synchronisation & Licensing: User Licenses, requirements for, purchasing of"  below.

3 Getting Help

Because of the embedded help and tool tips XE "Getting help" , using the RED SKY application is pretty much self explanatory, but should you need to get further assistance or advice for some particular problem, you can call the Red Sky Help Line:

· Australian users call tollfree on
 
1800-REDSKY

· New Zealand users call tollfree on

0508-REDSKY

Either of these numbers will connect you directly with the Cash Manager Computer Concepts Help Desk, which manages the Red Sky Help Line.  The Help Desk staff will record your call and provide the support you need.  In the event of a serious problem, your report will be forwarded to the RED SKY development team for further evaluation and assistance.

Help and feedback is also available posted on the www.redskyagri.com website XE "Red Sky Website" .

4 Application Overview

4.1 What is RED SKY?

First and foremost this package allows you to measure your “Return on Capital” and gives you the ability to compare this with other groups such as Top 10% NZ.
It does this by recording and tracking information about one or more farms owned or managed by you, or for which you provide accounting or farm consultancy services.

This information can include details of

· Total arable areas

· Areas used for various types of operations such as beef cattle, dairying or sheep.

· Registration and depreciation of assets such as land, buildings, vehicles and equipment.

· Fertiliser and irrigation usage

· Pasturage and other feed consumption

· Animal production figures, e.g. quantity of meat, milk and butterfat or fibre produced and the income from these sources.

· Other production figures, such as crop yields, hay and silage.

· Expenses such as Staff costs, vehicle running and maintenance costs, animal husbandry, feed and fertiliser overheads.

· Cashflow management

· Climate and landforms. 

· General notes.

From this data, RED SKY can generate financial reports such as balance sheets and cashflows, and production reports detailing individual performance.  Most of these can also be shown or printed in chart form.

As well as recording actual data for the current year, you can compare what is happening now with what happened in previous years, using the built-in year-on-year comparison facility XE "Comparing data" .  Alternatively you might want to compare your performance with other groups, or against a nationwide average.

You can also use this compare function to do “what-if” analysis- for instance“what-if” I bought that farm next door?  By putting in a forward projection based on the increased land areas you can see how it might affect your overall profitability.

Lastly,  RED SKY allows you to share your data with designated partners via the RED SKY Server XE “Server” .  This facility is password-protected which allows you to secure financial data or otherwise prevent unauthorised access.

4.2 How it Works.

4.2.1 Client vs Server XE "Server" 
The RED SKY Farm XE "Farm Maintenance"  Performance Analysis package is a Client/Server XE "Server"  application XE "Client/Server" : that means that it comes in two parts which work together to produce the desired result.
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Figure 1: RED SKY Application Structure.

The Client Pack, the bit that you as a Farmer/Client XE "Farmer/Client Maintenance"  see and use, is downloaded from the Internet and resides on your PC where it handles the day-to-day data entry functions, and generates the reports you request.  It also contains a local database XE "Database: Local database"  where the data you enter is stored and manipulated. 

The Client Pack consists XE "Client/Server: Client Pack"  of four processing modules:

· The Data Entry Module

· The Synchronisation Module XE "Synchronisation & Licensing" , which handles server communications and data transfer.

· The Account Management Module, which manages licensing.

· The Reporting Module, which generates the RED SKY reports and charts.  The Reporting Module is not turned on until you purchase a user license XE "Synchronisation & Licensing: User Licenses, requirements for, purchasing of" .
The Server XE "Server"  Pack resides XE "Client/Server: Server Pack"  on the RED SKY server, where it co-ordinates and consolidates data from many farmers or clients for group reporting and data sharing.  This data is held in the Server database, which is updated from  each Farmer/Client XE "Farmer/Client Maintenance" ’s local copy during Synchronisation. 

The Server XE "Server"  Pack has two processing modules:

· The Synchronisation Module XE "Synchronisation & Licensing" , which handles client communications and data transfer.

· The Account Management and Billing Module, which manages licensing and license payments.

4.2.2 Building Blocks XE "Database: Building Blocks" 
The core of the system is the RED SKY database XE "Database" .  This is where all of the details about you, your farm or farms, and your operation are stored.
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Figure 2: RED SKY Database Concepts

Basically it works like this:

· Farmers – or Clients - (that’s you) can have one or more Farms.

· Each Farm XE "Farm Maintenance"  has one or more sets of Year Data.  This is your day to day management record of income, expenses and production, plus any assets, liabilities and adjustments, and general notes you want to make.  Year data can be actual data or a projected budget for performance analysis later on.

· Farms can be grouped for reporting.  Reporting Groups exist independently of Farmer/Client XE "Farmer/Client Maintenance" s and can be password protected to prevent unauthorised changes.  However, any RED SKY user who knows the group password can perform group maintenance.  Once a group has been created and synchronised to the RED SKY server, XE "Synchronisation & Licensing: sharing data"  other Farmer/Clients can apply to add their farms to it and may share group data and receive group reports.

· Lastly, all of the active data in the RED SKY database XE "Database"  is supported by the application reference data XE "Database: application reference data" .  This includes such things as the location and country lists used for validation, the help text and tool tips, and other information required for the proper operation of the software.  This application reference data is maintained on the RED SKY Server XE “Server”  and copied to your local database XE "Database: Local database"  when you first install your copy of the RED SKY application.  It is refreshed automatically XE "Refreshing reference data"  whenever you do a synchronisation.

4.2.3 Using RED SKY XE "Using Red Sky" 
Typically, RED SKY will be used in one of two ways.  
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One is what might be called the Single Farmer/Client model XE "Using Red Sky: Single Client Model" , where one person will be handling all the records for the operations for which they are responsible.  In this situation, the single Farmer/Client XE "Farmer/Client Maintenance"  might be a farmer managing his own farm or farms, or possibly an accountant who is doing the books for such a Farmer/Client.

Figure 3: Using RED SKY XE "Using Red Sky" (1)~ The Single Farmer/Client XE "Farmer/Client Maintenance"  Model

Let’s look at the Single Farmer/Client XE "Farmer/Client Maintenance"  in more detail:

If you as a farmer want to use RED SKY to manage your enterprise: 

· First, you visit the RED SKY website XE "Red Sky Website"  and download the application software.

· Next, you have to describe both yourself and your farm or farms to the database.  To do this, you create yourself as a Farmer/Client XE "Farmer/Client Maintenance"  and enter your own farm details.  

· You can then go on and start entering your performance and financial details.  

It’s a good idea at this point for you to purchase a user license XE "Synchronisation & Licensing: User Licenses, requirements for, purchasing of" .  This identifies you and your farm(s) to the RED SKY server and opens up the full power of the Reporting Module for you to use.  

Now you can get on with entering your management data and start tracking your performance with RED SKY’s reports.  

Once in a while, you’ll synchronise with the server XE "Synchronisation & Licensing"  and generate some reports to see how your operation is doing.

That’s the simplest method, and for most Farmers and Clients that’s as complicated as it needs to get.
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Figure 4: Using RED SKY XE "Using Red Sky" (2)~ Group Farmer/Client XE "Farmer/Client Maintenance"  Model

The second option is the Group Farmer/Client XE "Farmer/Client Maintenance"  model XE "Using Red Sky: Group Client Model" .  This is more suited to larger enterprises, or perhaps an operation where the farmer is managing a number of farms, perhaps with the assistance of the company accountant or a Farm XE "Farm Maintenance"  Consultancy practice.  

In this case, you may not want to have to go through the initial steps of setting yourself up as a Farmer/Client XE "Farmer/Client Maintenance"  and defining all the farm and financial details to the system, especially if there are a number of them to do.  It’s probably easier to get your accountant or farm consultant to enter all those details for you.

Alternatively, an accountant or Farm XE "Farm Maintenance"  consultant may be managing accounts for, or advising on the management of a number of individual enterprises.  It’s easier for him to do all the initial set up work himself, so that he knows his clients’ details will all be set out the way he wants to see them.  So:

· He downloads the application from the RED SKY website XE "Red Sky Website"  

· He purchases his User Licenses, 

· He enters all the necessary setup data.  

· Then he synchronises his system XE "Synchronisation & Licensing"  with the RED SKY server to upload the Farmer/Client XE "Farmer/Client Maintenance"  details he has created for his clients, ready for them to retrieve and use.

Now the farmer only has to download the RED SKY Client Pack from the website XE "Red Sky Website"  and retrieve a predefined and licensed Farmer/Client XE "Farmer/Client Maintenance"  from the RED SKY server, all ready set up for him to start entering his management data and tracking his operation.

The third possibility is that the farmer will define the Farmer/Client XE "Farmer/Client Maintenance"  and farm details, and enter all his performance details into RED SKY for the day-to-day management of his operations, then allow his accountant or farm consultant to retrieve his Farmer/Client details for reporting and tax assessments.  In this case, the farmer 

· Downloads the application from the RED SKY website XE "Red Sky Website"  

· Purchases his user license XE "Synchronisation & Licensing: User Licenses, requirements for, purchasing of" s, 

· Enters all the necessary setup data.  

· Synchronises his system with the RED SKY server to upload the Farmer/Client XE "Farmer/Client Maintenance"  details he has created.

The farmer’s accountant or consultant now uses his own copy of the RED SKY Client Pack to retrieve the farmer’s predefined and licensed Farmer/Client XE "Farmer/Client Maintenance"  from the RED SKY server for reporting and analysis.

From here on, there are no real differences in the way either type of Farmer/Client XE "Farmer/Client Maintenance"  works with the application.

5 The Grass Roots User Guide

Note: The screenshot illustrations in this section are taken from Versions 1.0.09  of the application software.  There have been no significant changes to the screen formats since that version.

The topics in this section of the User Guide show you how to:

· Navigate your way around your copy of RED SKY.

· Create and maintain your own Farmer/Client definitions

· Create and maintain your own Farm definitions

· Create and maintain your own Farm Groups

· Manage your Year data

· Set and remove comparison Years

· Copy and rollover Years

· Synchronise your data with the RED SKY database server

5.1 Opening the Box.

When you fire up RED SKY for the first time, you’ll see something like this:
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Figure 5: Red Sky Splash Screen

This splash screen XE "Splash Screen"  is the first thing you will normally see whenever you launch the RED SKY application.  It tells you what version of the software you are currently using and what operating system configurations are needed to support it.

If you don’t want to see this every time you start the application, you can turn it off by unchecking the Options XE "System Options" :General tab XE "System Options:General"  Show Splash Screen checkbox XE "Splash Screen:turning on, see System Options" 

 XE "Splash Screen:turning off, see System Options" .  

5.1.1 Ready, Steady……GO!

The initial application download provides you with a ready-formatted empty database and the RED SKY Client Pack.

Before you can begin using RED SKY to record your farm management data, it needs to know some things about you and the farm or farms you will be recording data for.  Specifically, you need to identify yourself to the system with a Farmer/Client XE "Farmer/Client Maintenance"  login XE "Login Name, Login User ID"  name and you need to define your usable farm areas and some other details about your farm operation.

Luckily we’ve provided a built-in road map to help you along the way.  It’s called the Start-Up Wizard XE "Initial Setup: Start-Up Wizard" , and the next few pages describe how it will help you get out of the box and into the paddock.

5.1.2 First Things First: The Start Up Wizard.

Let’s take a look at what you need to do to get your copy of RED SKY up and running.

Because of the way RED SKY organises your data, you will need to do your initial set up in a specific order;
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Figure 6: Setting Up RED SKY.

You’ll notice this diagram doesn’t mention Groups.  Once you’ve done your initial setup you can define a Group at any time and add farms to it as and when required.

To help you get through this in the proper order, we’ve provided the Start-Up Wizard XE "Initial Setup: Start-Up Wizard" .

When you first launch RED SKY with an empty database, the Start-Up Wizard XE "Initial Setup: Start-Up Wizard"  is triggered.  It automatically leads you step by step through the set up process, to define your Farmer/Client XE "Farmer/Client Maintenance"  name and load information about the farm you will be managing.  When all the required information is collected, the Start-Up Wizard has done its job and it closes down, leaving the application completely ready to use.

5.1.2.1 Step 1 – Setting Your Preferences XE "Initial Setup: Start-Up Wizard: Setting Preferences" 
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Figure 7: The Initial Setup Wizard (1)~ Setting Preferences.

The first step in the process is to define your default options for country, location and locale.  These in turn define what units of measurement and currency the RED SKY application will assume for your data.

Country, Location and Locale XE "Initial Setup: Setting Preferences"  are selected from the drop-down lists attached to each field.  Whatever you select here will be used as the default values for each farm you create later.

The checkboxes in the bottom left-hand corner indicate 

· whether you want to see the Tool Tip help text on each of the RED SKY application panels 

· Whether this Startup Wizard should be shown in future if the database is empty.

Both boxes are checked by default but you can uncheck them if you want to turn off either Tool Tips XE "Getting help: Tool Tips"  or the Wizard.  Both options can be reset using the Options XE "System Options"  function if you change your mind later on, so it’s probably best to accept the defaults at this time.

When you’ve selected your default options, click the Next button to continue.

5.1.2.2 Step 2 – Creating Your Farmer/Client XE "Farmer/Client Maintenance"  Login Name. XE "Initial Setup: Start-Up Wizard: Creating the first Farmer/Client" 
The next step is to create a Farmer/Client XE "Farmer/Client Maintenance"  definition.  This is your unique login id for the RED SKY application.  You can either create your own login id now or retrieve a previously defined one from the RED SKY Server XE “Server” .  Read Section 5.2.4 Retrieving a Predefined Farmer/Client to find out about retrieving a predefined user.

5.1.2.3 Step 3 – Creating Your First Farm XE "Initial Setup: Start-Up Wizard: Creating the first Farm" 

 XE "Farm Maintenance" 
Once you have created your Farmer/Client XE "Farmer/Client Maintenance"  login XE "Login Name, Login User ID"  name, you will need to create at least one Farm XE "Farm Maintenance"  “owned” by the Farmer/Client.  Alternatively, if you have retrieved a predefined Farmer/Client from the Server XE “Server” , all the necessary Farm details may already have been created for you to use.

5.1.2.4 Step 4 – Creating Your First Year XE "Initial Setup: Start-Up Wizard: Creating the first Year" 
After creating the Farmer/Client XE "Farmer/Client Maintenance"  and Farm XE "Farm Maintenance" , you will go on to create a Year which will be used to enter up all your performance data later on.  Alternatively, if you have retrieved a predefined Farmer/Client from the Server XE “Server” , all the necessary Year details may already have been created for you to use.

5.1.3 Where Do I Go From Here? ~ Navigation and Other Things
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Figure 8: RED SKY Main Menu Panel

Navigation in RED SKY is usually handled from the Main Menu panel XE "Navigation: using the Main Menu" 

 XE "Main Menu" . This is the one shown in Figure 8 above.

Each navigation button XE "Navigation: using the Main Menu" 

 XE "Main Menu: navigation"  on the Main Menu panel XE "Main Menu"  launches one of the major functions of the RED SKY application:

	Years
	Year Maintenance 

	Farms
	Farm XE "Farm Maintenance"  Maintenance

	Farm XE "Farm Maintenance"  Groups XE "Farm Group Maintenance" 
	Farm XE "Farm Maintenance"  Group XE "Farm Group Maintenance"  Maintenance

	Farmer/Clients XE "Farmer/Client Maintenance" 
	Farmer/Client XE "Farmer/Client Maintenance"  Maintenance & Retrieve Farmer/Client functions

	Synchronise
	Synchronise with Server XE "Synchronisation & Licensing" 

 XE "Server"  & update user licenses XE "Synchronisation & Licensing: User Licenses, requirements for, purchasing of" 

	Options XE "System Options" 
	Application administration options

	Exit
	Close the application and return to the desktop


All of these functions can be accessed from the File Menu XE "Navigation: using the File Menu" , as shown below.  If you prefer to use the File Menu and or the predefined HotKeys for navigation and would rather not see the Main Menu panel XE "Main Menu" , check the Hide this screen checkbox XE "Main Menu: turning off"  on the Main Menu panel the first time it appears.  The Main Menu will then be hidden until you turn it on using the Main Menu option of the View Menu XE "Main Menu: turning on" 

 XE "Main Menu: option on the View Menu" 

 XE "View Menu: Main Menu option" .

5.1.3.1 The File Menu XE "Navigation: using the File Menu" .
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Figure 9:The File Menu XE "Navigation: using the File Menu" .

If you don’t want to use the Main Menu panel XE "Main Menu"  all the time, the File Menu XE "Navigation: using the File Menu"  gives you an alternative way of accessing the main functions of the RED SKY application:

	Years
	Opens the Year Maintenance Window.  You can also use the HotKey XE "Navigation: using the HotKeys" 

 XE "HotKey Navigation"  shortcut CTRL-Y to open this window from anywhere in RED SKY.  

	Farmer/Clients XE "Farmer/Client Maintenance" 
	Opens the Farmer/Client XE "Farmer/Client Maintenance"  Maintenance Window.  You can also use the HotKey XE "Navigation: using the HotKeys" 

 XE "HotKey Navigation"  shortcut CTRL-U to open this window from anywhere in RED SKY..

	Farms
	Opens the Farm XE "Farm Maintenance"  Maintenance Window.  You can also use the HotKey XE "Navigation: using the HotKeys" 

 XE "HotKey Navigation"  shortcut CTRL-F to open this window from anywhere in RED SKY..

	Farm XE "Farm Maintenance"  Groups XE "Farm Group Maintenance" 
	Opens the Group Maintenance Window.  You can also use the HotKey XE "Navigation: using the HotKeys" 

 XE "HotKey Navigation"  shortcut CTRL-G to open this window from anywhere in RED SKY.

	Synchronise with Server XE "Synchronisation & Licensing" 

 XE "Server" 
	Opens the Synchronise dialog which checks your User Licenses and synchronises your local database XE "Database: Local database"  with the RED SKY server database. XE "Database: Server database"   You can also use the HotKey XE "Navigation: using the HotKeys" 

 XE "HotKey Navigation"  shortcut CTRL-S to open this window anywhere in RED SKY. XE "Databases Server database" 

	Refresh Static Data XE "Refreshing Static Data" 
	Refreshes your local copy of the RED SKY reference data from  the RED SKY server database. XE "Database: Server database"   You can also use the HotKey XE "Navigation: using the HotKeys" 

 XE "HotKey Navigation"  shortcut CTRL-D to open this window anywhere in RED SKY. XE "Databases Server database" 

	Retrieve Farmer/Client XE "Farmer/Client Maintenance" 
	Retrieves a predefined Farmer/Client XE "Farmer/Client Maintenance"  and all its associated Farm, XE "Farm Maintenance"  Group and Year data from  the RED SKY server database. XE "Database: Server database"   You can also use the HotKey XE "Navigation: using the HotKeys" 

 XE "HotKey Navigation"  shortcut CTRL-E to open this window anywhere in RED SKY. XE "Databases Server database" 

	Reset Grid Column Settings XE "Grid Column Widths: resetting" 
	The data grids used to display or capture RED SKY data can be adjusted by placing the mouse pointer on the gridline and dragging them to give a wider or narrower column width.  This option resets all data grids modified in this way to the default width.  You can also use the HotKey XE "Navigation: using the HotKeys" 

 XE "HotKey Navigation"  shortcut CTRL-R to activate this function from anywhere in RED SKY..

	Exit
	Exits RED SKY and returns you to the Desktop.


HotKey XE "Navigation: using the HotKeys" 

 XE "HotKey Navigation"  shortcuts XE "Shortcut Keys, see HotKeys, Navigation using" 

 XE "HotKeys, see Navigation"  are activated by pressing the CTRL and specified letter keys both together; for example

CTRL + U XE "Navigation: using the HotKeys: Farmer/Client Maintenance" 

 XE "HotKey Navigation: Farmer/Client Maintenance"  will activate the Farmer/Client XE "Farmer/Client Maintenance"  Maintenance function.

HotKeys can be used from any point in the RED SKY application.

5.1.3.2 The View Menu XE "View Menu: Main Menu option" 
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Figure 10: The View Menu XE "View Menu: Main Menu option" .

The View Menu XE "View Menu: Main Menu option"  gives you choices about how the RED SKY screens will be displayed to you.  It provides an alternative way to access the Main Menu panel XE "Main Menu"  if it has been previously hidden, and also gives access to the Options XE "System Options"  maintenance window when the Main Menu is hidden.

	Main Menu
	Shows or hides the Main Menu panel. XE "Main Menu" 

	Help Tips XE "Getting help: Tool Tips" 
	Shows or hides the Help Tips XE "Getting help: Tool Tips"  for the RED SKY data grids

	Status Bar XE "View Menu: Status Bar option" 

 XE "Status Bar: using the" 
	Shows or hides the Status Bar XE "Status Bar: Showing & Hiding the" 

 XE "View Menu: Status Bar option" 

 XE "Status Bar: using the"  at the bottom of the screen

	Options XE "System Options" 
	Opens the System Administration Options XE "System Options"  window


5.1.3.3 The Window Menu XE "Window Menu" 
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Figure 11: The Window Menu XE "Window Menu" .

The Window Menu XE "Window Menu"  allows you to control how RED SKY presents the various detail windows to you for data entry or data display:

	New Window
	

	Cascade XE "Window Menu: Cascade windows" 
	Shows all open windows cascading from the top left corner diagonally towards the bottom right corner.  

	Tile Horizontal XE "Window Menu: horizontal tiling" 
	Allows you to view two or more windows one above the other.

	Tile Vertical XE "Window Menu: vertical tiling" 
	Allows you to see two or more windows side by side

	Arrange Icons
	

	( 1 Active Window

2 Inactive Window
	This menu item lists all the RED SKY windows you have open at this time.  The current active window is indicated by a (.  You can use this list to switch between open windows at any time.


Figure 12, Figure 13 and Figure 14 on the following pages show how the Cascade XE "Window Menu: Cascade windows" , Tile Horizontal XE "Window Menu: horizontal tiling"  and Tile Vertical XE "Window Menu: vertical tiling"  options affect the way RED SKY presents the data screens.

Figure 15 shows how the Windows Menu Open Window list identifies the current active window.
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Figure 12: Cascading Windows.
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Figure 13: Horizontally Tiled Windows.
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Figure 14: Vertically Tiled Windows
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Figure 15: Using the Windows Menu to select the Active Window.

5.1.3.4 The Help Menu

[image: image14.png]|20 |5 B o] o | [ O 2 A ) S | 11 25

File View Winda,

REE

FarmeriClients Farm Groups

Farms Synchronise

Exit Red Sky

T~ Hide this screen

Databosev02240Path C\PROGRAM FLESNRED SKADaabaseHdSky b o [15%

HAstart] | A € & > ||[EERed sky v1.0.9 ) Red Sky User Manu...| 3 Windows Media Pla. SEE 1538





Figure 16: The Help Menu.

The Help Menu displays information about the version of the software XE "Help Menu: software version information"  you are currently using and optionally the system it is running on.

	About
	Displays information about the version of the software.


For example:
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Figure 17: RED SKY About Screen

An example of the system information display is given in Appendix A: System Configurations.
5.1.4 Some Handy Things to Know…

When you open each of the major maintenance functions of the RED SKY application, the first thing you will see is the Maintenance Selection List XE "Selection Lists"  for that function.  This is a list of all the items of that type currently existing in your local database XE "Database: Local database" .  Unless you have literally just completed synchronisation XE "Synchronisation & Licensing" , it does not necessarily reflect what is stored on the RED SKY server database XE "Databases Server database" 

 XE "Database: Server database" .

When you are looking at any one of the Maintenance Selection List XE "Selection Lists" s, you can open the Edit Window for a selected item simply by putting the mouse cursor on it and double-clicking the left mouse button

When you are looking at any one of the Maintenance Selection List XE "Selection Lists" s, you can change the order in which the items are presented by clicking on the column headings.

When you are entering data values into the cashflow grids, you can use the normal arithmetic operators to perform calculations as you enter your data.
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Figure 18: Using and Sorting the Maintenance Selection List XE "Selection Lists" s.

5.2 Creating and Maintaining Farmer/Client XE "Farmer/Client Maintenance"  Definitions

RED SKY Farmer/Client XE "Farmer/Client Maintenance" s are created and maintained using the Farmer/Client Maintenance function, which is launched either 

· from the Farmer/Client XE "Farmer/Client Maintenance" s navigation button XE "Navigation: using the Main Menu" 

 XE "Main Menu: navigation"  on the Main Menu panel XE "Main Menu" , or 

· from the Farmer/Client XE "Farmer/Client Maintenance" s option of the File Menu XE "Navigation: using the File Menu" , or 

· by using the CTRL-U Farmer/Client XE "Farmer/Client Maintenance" s HotKey XE "Navigation: using the HotKeys" 

 XE "HotKey Navigation"  

to open the Farmer/Client XE "Farmer/Client Maintenance"  Maintenance Selection List XE "Selection Lists"  window shown in Figure 19 below.

5.2.1 Creating a New Farmer/Client XE "Farmer/Client Maintenance" .
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Figure 19: Creating a New Farmer/Client XE "Farmer/Client Maintenance" 
To create a new Farmer/Client XE "Login Name, Login User ID:" 

 XE "Farmer/Client Maintenance: creating new" 

 XE "Farmer/Client Maintenance" :

· Click on the New button to open the New Farmer/Client XE "Farmer/Client Maintenance"  Edit window. 

· Enter your new Farmer/Client XE "Farmer/Client Maintenance"  details as shown in Figure 20 below.  Mandatory fields must be filled in.

	Field Name:
	Content:
	Mandatory:

	Login Name
	Enter a short name or nickname which identifies each Farmer/Client XE "Farmer/Client Maintenance"  to the system

This name must be unique to the RED SKY application, and your desktop software will do an Internet lookup to make sure that it is.
	Yes

	Full Name
	Enter the Farmer/Client’ XE "Farmer/Client Maintenance" s full name for reporting purposes
	Yes

	Email Address
	Enter the Farmer/Client’ XE "Farmer/Client Maintenance" s usual email address for contact
	Yes

	Phone Number
	Enter the Farmer/Client’ XE "Farmer/Client Maintenance" s usual contact phone number
	Yes

	Remember Password? XE "Password Protection: Remember Password option" 
	Check this box if you want the RED SKY Client Pack to remember the login password between sessions.  

This feature applies only to the PC you are using~ this password will not be available to any other Farmer/Clients XE "Farmer/Client Maintenance"  or to different PCs.
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Figure 20: The New Farmer/Client XE "Farmer/Client Maintenance"  Edit Window.

Click OK to accept the details you’ve just entered.

When you create a new Farmer/Client XE "Login Name, Login User ID:" 

 XE "Farmer/Client Maintenance: creating new" 

 XE "Farmer/Client Maintenance" , the RED SKY application insists that your chosen login name XE "Login Name, Login User ID"  must be unique not only in your own local copy of the RED SKY database XE "Database"  but also in the RED SKY Server XE “Server”  database XE "Databases Server database" .  This is to ensure that your data is correctly identified and associated only with your own login name even though it has been synchronised to the Server’s consolidated database XE "Synchronisation & Licensing" .

To ensure your new login name XE "Login Name, Login User ID"  is unique, the RED SKY application goes to the Internet and looks up your chosen login name in the RED SKY Server XE “Server”  database XE "Databases Server database"  before accepting your new entry.  Click the OK button to complete the check.

If your chosen login name XE "Login Name, Login User ID"  is not unique in both databases, you will be prompted to enter another choice before continuing.
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Figure 21: Creating a new Farmer/Client XE "Farmer/Client Maintenance"  ~ Checking Login Uniqueness

Next, you will be prompted to enter a password for this Farmer/Client XE "Farmer/Client Maintenance" :  Figure 22 below shows the Password popup.  

· Enter your chosen password in the Password box and repeat it exactly in the Confirm Password box.  Passwords must be at least 6 alphabetic or numeric characters in length. There must be at least one numeric character in the string.  Both passwords are hidden at all times.

· If the two versions are different, the password is not accepted and you will be prompted to repeat the process.

Click OK to accept the password you’ve just entered

When you set a password for your Farmer/Client XE "Farmer/Client Maintenance"  login XE "Login Name, Login User ID" , you have the option of having the RED SKY application remember that password for you between sessions.  To do this you must check the checkbox “Remember Password XE "Password Protection: Remember Password option"  on this Machine?”  If the “Remember Password” box is not checked then you will be prompted for your password whenever you edit your Farmer/Client login, or any farm or year data associated with it.
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Figure 22: New Farmer/Client XE "Farmer/Client Maintenance"  Password Prompt.

That’s it! 

Your new Farmer/Client XE "Farmer/Client Maintenance"  is created, and the New Farmer/Client Edit window closes, returning you to the Farmer/Client Maintenance Selection list.  You can see the new Farmer/Client you’ve just created is now showing in the Selection list window:
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Figure 23: New Farmer/Client XE "Farmer/Client Maintenance"  successfully created.

5.2.2 Changing an Existing Farmer/Client XE "Farmer/Client Maintenance" 
Before you can perform any maintenance on an existing Farmer/Client XE "Farmer/Client Maintenance: maintaining existing"  definition (or Farms and Years associated with it) you must give the appropriate password.  If the Remember Password XE "Password Protection: Remember Password option"  box wasn’t checked when that Farmer/Client XE "Farmer/Client Maintenance"  was created, then you will be prompted to give the login password before RED SKY will allow you to continue.  If the Remember Password box was checked then RED SKY recovers the password from its own memory and assumes you are authorised to go ahead.
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Figure 24: Changing an Existing Farmer/Client XE "Farmer/Client Maintenance" ’s Details.

To change an existing Farmer/Client XE "Farmer/Client Maintenance" ’s details:

· Open the Farmer/Client XE "Farmer/Client Maintenance"  Maintenance Selection List XE "Selection Lists" .

· Select the Farmer/Client XE "Farmer/Client Maintenance"  you want to edit by moving the mouse pointer to it and clicking the left mouse button

· Double-click the left mouse button or click on the Edit button to open the Farmer/Client XE "Farmer/Client Maintenance"  Edit window. Figure 25 below shows this.

· Change the Farmer/Client XE "Farmer/Client Maintenance"  details as necessary. Mandatory fields must be filled in.

· You can change the Farmer/Client XE "Farmer/Client Maintenance"  password at this point by clicking the 

Change Password button on this window.

· Click the OK button to accept your changes.
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Figure 25: Editing an Existing Farmer/Client XE "Farmer/Client Maintenance" ’s Details.

5.2.3 Changing Passwords
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Figure 26: Changing Passwords

It’s very simple to change an existing password XE "Password Protection: setting & changing Farmer/Client passwords" 

 XE "Password Protection" 

 XE "Farmer/Client Maintenance: passwords, setting & changing"  or set a new password for a Farmer/Client XE "Farmer/Client Maintenance"  who did not originally have one.

· Use the Farmer/Client XE "Farmer/Client Maintenance"  navigation button XE "Navigation: using the Main Menu" 

 XE "Main Menu: navigation"  of the Main Menu panel XE "Main Menu" , or open the File Menu XE "Navigation: using the File Menu"  and select the Farmer/Client option, or press the CTRL-U HotKey XE "Navigation: using the HotKeys" 

 XE "HotKey Navigation"  to open the Farmer/Client Maintenance Selection window.

· Select the Farmer/Client XE "Farmer/Client Maintenance"  you want to edit by moving the mouse pointer to it and clicking the left mouse button

· Click on the Edit button to open the Farmer/Client XE "Farmer/Client Maintenance"  Edit window.

· Click the Change Password button.  

· When the Password Popup appears:

· Enter the original password in the Old Password box if there was one.  Otherwise just click on the Old Password box.

· Enter the new password in the New Password box.  Your password must be at least 6 alphanumeric characters long and contain at least one numeric character.

· Repeat the new password in the Confirm Password box, exactly as you entered it the first time.  Figure 26 above shows the result.

· Click the OK button to accept your changes.

The Farmer/Client XE "Farmer/Client Maintenance"  password is now changed.

5.2.4 Retrieving a Predefined Farmer/Client XE "Farmer/Client Maintenance" 
Normally you would create your own Farmer/Client XE "Farmer/Client Maintenance"  details by entering them directly into your own local copy of the RED SKY application.  Sometimes, however, you may need to view or manage information which has been set up by someone else.  Typically this would be the case when an account or farm consultant is reviewing or manipulating for reporting purposes production figures and cashflow details entered on a day to day basis by an individual Farmer/Client.

In such cases it is necessary to retrieve the predefined Farmer/Client XE "Retrieving a predefined user" 

 XE "Farmer/Client: retrieving predefined" 

 XE "Farmer/Client Maintenance" 

 XE "Retrieving a predefined Farmer/Client" , together with all the associated farm, group and year data from the RED SKY server.

Obviously, both the original owner of the data and the person doing the reviewing must have purchased licenses and subscribed to the RED SKY server in order to do this, since the server collates the data and is the medium of exchange between individual users of the application.
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Figure 27: Retrieving an Existing Farmer/Client XE "Farmer/Client Maintenance" 's Details(1) ~ Starting the Retrieve Dialog.

Once both parties have purchased their licenses, retrieving predefined details in this way is easy.

First, the Farmer/Client XE "Farmer/Client Maintenance"  who created the data (the “owner” of the data) must synchronise XE "Synchronisation & Licensing: sharing data"  his/her local copy of the RED SKY database XE "Database"  with the RED SKY server.  This process is covered in the section Synchronisation & Licensing.  Doing so uploads predefined Farm XE "Farm Maintenance"  and Farm Group XE "Farm Group Maintenance"  details, together with all associated Year data to the RED SKY server.

To retrieve the data for review, you must be authorised XE "Farmer/Client: retrieving predefined: authorisation of"  to do so with the appropriate login name XE "Login Name, Login User ID"  and password to access it, given to you by the owner either verbally or perhaps via email or maybe even snail mail.

Then, from the Farmer/Client XE "Farmer/Client Maintenance"  selection list XE "Selection Lists"  you:

· Click the Retrieve button to start the Retrieve dialog

· Enter the unique User name, i.e. the login name XE "Login Name, Login User ID"  of the Farmer/Client XE "Farmer/Client Maintenance"  you want to retrieve, and the password you have been given.
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Figure 28: Retrieving an Existing Farmer/Client XE "Farmer/Client Maintenance" 's Details(2) ~ Entering User Name & Password.

The Retrieve process then connects to the Internet to check that the user name and password are valid.
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Figure 29: Retrieving and Existing Farmer/Client's Details(3) ~ Connecting to the Internet

If they are, the process begins to download the nominated Farmer/Client XE "Farmer/Client Maintenance"  details, together with all the associated Farm XE "Farm Maintenance" , Farm Group XE "Farm Group Maintenance"  and Year details residing on the RED SKY Server XE “Server”  and loads them into your local copy of the RED SKY database XE "Database" .

Be aware, however, that this retrieval process XE "Farmer/Client: retrieving predefined: data snapshots, versions of"  provides only a snapshot of the data as it currently exists on the RED SKY Server XE “Server” .  If  the owner has updated it locally in the interim and not performed a synchronisation, then what you retrieve will not be the latest version.  Similarly, if you are the one who is changing things, your updates will not be available to the other party until you perform a synchronisation to upload your changes.

When in doubt, check with the other party to make sure you will be getting what you expect to retrieve.

5.3 Creating and Maintaining Farm XE "Farm Maintenance"  Definitions

RED SKY farm definitions are created and maintained using the Farm XE "Farm Maintenance"  Maintenance function which is launched either 

· from the Farms navigation button XE "Navigation: using the Main Menu" 

 XE "Main Menu: navigation"  on the Main Menu panel XE "Main Menu" , or 

· from the Farms option of the File Menu XE "Navigation: using the File Menu" , or 

· by using the CTRL-F Farms HotKey XE "Navigation: using the HotKeys" 

 XE "HotKey Navigation"  

to open the Farm XE "Farm Maintenance"  Maintenance Selection List XE "Selection Lists"  window shown in Figure 30 below.

5.3.1 Creating a New Farm XE "Farm Maintenance"  Definition
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Figure 30: The Farm XE "Farm Maintenance"  Maintenance Selection List XE "Selection Lists" .

To create a new farm:

· Click on the New button to open the New Farm XE "Farm Maintenance"  Edit window. 

· Enter your new farm details as shown in Figure 31 below.  Mandatory fields must be filled in.

	Field Name:
	Content:
	Mandatory:

	Farm XE "Farm Maintenance"  Name
	Enter the name of the farm you are adding here
	Yes

	Franchise:
	If this farm is part of a franchise operation, you can enter the name of the franchise here.  Otherwise, enter “None”.
	no

	Consultant:
	If you use a Farm XE "Farm Maintenance"  Consultant, or other professional assistance, you can enter that name here.  Otherwise, enter “None”.
	no

	Farmer/ Client:
	This is the Farmer/Client XE "Farmer/Client Maintenance"  login XE "Login Name, Login User ID"  name of the farmer or client that administers this farm.  

Click on the down arrow and pick a Farmer/Client XE "Farmer/Client Maintenance"  name from the list of valid Farmer/Client logins XE "Login Name, Login User ID" .
	Yes

	Country
	The country the farm is located in.
	Yes

	District/ Location:
	Enter the district or location of the farm.  This is usually the name of the nearest city or township, or it could be a regional name, such as South Waikato.

Click on the down arrow and pick a location from the list of valid locations for the country you selected.
	Yes

	Locale:
	Enter the geographical region or country where the farm is situated.

Click on the down arrow and pick a location from the list of countries.
	Yes

	License:
	This field shows the current license expiry date for this farm
	Information Only

	Years with Editable Areas

Used

License Allowance
	This fields in this panel show the license allowances for Editable Years

· Editable Years actually used

· Number of Editable Years allowed on this license
	Information Only
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Figure 31: The New Farm XE "Farm Maintenance"  Edit Window.

This completes the basic details for the farm but the various production land areas must still be set XE "Farm Maintenance: defining production areas & activities" .  This function is controlled by the Edit Area button.

5.3.2 Defining Farm XE "Farm Maintenance"  Activities & Production Areas.

When you click the Edit Area button, RED SKY checks whether your User License is up to date.  If you are changing area details for a farm which is already licensed, you will see a warning message like this:
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Figure 32 below shows the open Edit Areas window.  This is where you define the total farm area, indicate what production activities you are running and how much of the total land area is devoted to each type of production.  Areas can be in either acres or hectares: the unit of measure is defined by your system preferences and implicit throughout the RED SKY application.
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Figure 32: Edit Farm XE "Farm Maintenance"  Area Window

Unless any given Production Activity type is selected by checking the corresponding check-box, the total farm area is the only mandatory field here.

Once a Production Activity type is selected, you must enter at least one area value for that activity.

· The Effective Area is the land area which is actually devoted to the selected production activity.

· The Non-Effective Area is an estimate of the land area occupied by facilities required to support or service the selected production activity, e.g. races, yards and buildings.  Where multiple activities are selected and the facilites are shared, this figure will be a share of the total non-effective area, apportioned over all the selected production activities.

The sum of the land areas for all selected production activities must equal the specified total farm area.
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Figure 33: Effective Activity Areas

Figure 33 shows the how the effective areas have been set for this farm.  

Once the production activities and effective areas have been either set or changed, the next synchronisation forces the purchase XE "Synchronisation & Licensing: User Licenses, requirements for, purchasing of"  of a new license for this farm.  
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Figure 34: Creating a New Farm ~ Farm definition created.

5.3.3 Changing an Existing Farm XE "Farm Maintenance"  Definition
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Figure 35: Editing an Existing Farm XE "Farm Maintenance" 
To edit details for an existing farm XE "Farm Maintenance: maintaining existing" :

· Open the Farm XE "Farm Maintenance"  Maintenance Selection List XE "Selection Lists" .

· Select the farm you want to edit by placing the mouse curson on it and clicking the left mouse button once.  The selected farm is highlighted with a coloured bar.

· Click on the Edit button or double click the left mouse button to open the Farm XE "Farm Maintenance"  Edit window. 

· Enter your amended farm details as shown in Figure 36 below.  

The Farm XE "Farm Maintenance"  Edit window works in the same way as the New Farm window.  You can change any field shown, but mandatory fields must not be blank, and if you change the farm activity areas using the Edit Areas button, you will need to purchase a new license at the next synchronisation. XE "Synchronisation & Licensing: User Licenses, requirements for, purchasing of" 
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Figure 36: The Farm XE "Farm Maintenance"  Edit Window

5.4 Creating and Maintaining Farm XE "Farm Maintenance"  Group XE "Farm Group Maintenance" s

Farm XE "Farm Maintenance"  Group XE "Farm Group Maintenance" s allow you to share XE "Farm Groups: sharing data"  your performance analysis with other interested parties, and to share performance statistics from other operations in return.  Group data shared in this way can be reported overall and used to provide an industry or area standard against which to measure individual performance.

To participate in group reporting XE "Farm Groups: Group Reporting" , you must first either create a new group for others to join or join an existing group created by someone else.  Existing groups are made available from the RED SKY server during Retrieve Farmer/Client XE "Farmer/Client Maintenance"  and synchronisation processing.

Farm XE "Farm Maintenance"  Group XE "Farm Group Maintenance" s exist independently of any Farmer/Client XE "Farmer/Client Maintenance" , but like the Farmer/Client definition, they may be password-protected to prevent unauthorised changes being made.  That said, however, any RED SKY user who is authorised with the correct password may maintain a Farm Group.

Farm XE "Farm Maintenance"  Group XE "Farm Group Maintenance" s are created and maintained using the Farm Group Maintenance function, which is launched either 

· from the Farm XE "Farm Maintenance"  Group XE "Farm Group Maintenance" s navigation button XE "Navigation: using the Main Menu" 

 XE "Main Menu: navigation"  on the Main Menu panel XE "Main Menu" , or 

· from the Farm XE "Farm Maintenance"  Group XE "Farm Group Maintenance" s option of the File Menu XE "Navigation: using the File Menu" , or 

· by using the CTRL-G Farm XE "Farm Maintenance"  Group XE "Farm Group Maintenance" s HotKey XE "Navigation: using the HotKeys" 

 XE "HotKey Navigation"  

Use any of these methods to open the Farm XE "Farm Maintenance"  Group XE "Farm Group Maintenance"  Maintenance Selection List XE "Selection Lists"  window shown in Figure 37 below.

5.4.1 Creating a New Farm XE "Farm Maintenance"  Group XE "Farm Group Maintenance" 
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Figure 37: The Farm XE "Farm Maintenance"  Group XE "Farm Group Maintenance"   Maintenance Selection List

To create a new farm group XE "Farm Groups: creating a new Farm Group" :

· Click on the New button to open the New Farm XE "Farm Maintenance"  Group XE "Farm Group Maintenance"  window.  XE "Selection Lists" 
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Figure 38: Creating a New Farm XE "Farm Maintenance"  Group ~ the Farm Group Maintenance Window. 

When the New Farm Group maintenance window opens, 

· enter your new farm group details as shown in Figure 38 above.  Mandatory fields must be filled in.

	Field Name:
	Content:
	Mandatory:

	Group Name
	Enter the name of the farm group you are adding here
	Yes

	Type
	Select a group type description from the drop-down list or enter N/A if none is applicable
	Yes

	Remember Password XE "Password Protection: Remember Password option" 
	Check the box if you want the group maintenance password to be remembered between sessions.

This feature applies only to the PC you are using~ this password will not be available to any other Farmer/Clients XE "Farmer/Client Maintenance"  or to different PCs.
	


· Click the OK button to create the new farm group.

Once you have created your new group you will be prompted to enter a password for it.  Farm XE "Farm Maintenance"  Group XE "Farm Group Maintenance"  passwords are mandatory and  XE "Password Protection: setting & changing Farm Group passwords" 

 XE "Farm Groups: password protection of" operate just like individual Farmer/Client XE "Farmer/Client Maintenance"  passwords to protect the group’s definition and membership from unauthorised maintenance.  Once the password is set  for a particular group you have the option of having the RED SKY application remember it for you on that PC only.

To have the group password remembered XE "Password Protection: Remember Password option" , click the Remember Password on this Machine checkbox.  If  you leave this box unchecked, you will be prompted to enter the group password whenever you edit the group.

· Enter your chosen password in the Password box and repeat it exactly in the Confirm Password box.  Passwords must be at least 6 alphabetic or numeric characters in length. There must be at least one numeric character in the string.  Both passwords are hidden at all times.

· If the two versions are different, the password is not accepted and you will be prompted to repeat the process.

Click OK to accept the password you’ve just entered
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Figure 39: Creating a New Farm Group(2) ~ Setting the Password
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Figure 40: New Farm Group successfully created

The new group is now created and shows on the Group Maintenance Selection list.

5.4.2 Changing an Existing Farm XE "Farm Maintenance"  Group XE "Farm Group Maintenance" 
Before you can perform any maintenance on an existing Group XE "Farm Groups: password protection of"  definition you must give the appropriate password.  If the Remember Password XE "Password Protection: Remember Password option"  box wasn’t checked when that Group was created, then you will be prompted to give the login password before RED SKY will allow you to continue.  If the Remember Password box was checked then RED SKY recovers the password from its own memory and assumes you are authorised to go ahead.
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To edit details for an existing Farm XE "Farm Maintenance"  Group XE "Farm Groups: maintaining existing" 

 XE "Farm Group Maintenance" :

· Open the Farm XE "Farm Maintenance"  Group XE "Farm Group Maintenance"  Maintenance Selection List XE "Selection Lists" .

· Select the farm group you want to edit by placing the mouse curson on it and clicking the left mouse button once.  The selected group is highlighted with a coloured bar.

· Click on the Edit button to open the Group Edit window. 

The Group Edit window works in the same way as the New Group window and you can change the group name or type.  

It is also the mechanism for adding farms to and removing farms from the group XE "Farm Groups: managing membership of" .
Before we look more closely at that, let’s first find out how a RED SKY Farmer/Client XE "Farmer/Client Maintenance"  can apply to join a group.

5.4.3 Applying to Join a Farm XE "Farm Maintenance"  Group XE "Farm Group Maintenance" 
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Figure 41: Joining Farm XE "Farm Maintenance"  Group XE "Farm Group Maintenance" s

To join a farm group XE "Farm Groups: joining" , you

· Open the Farm XE "Farm Maintenance"  Maintenance Selection list

· Select the farm you want included in the group by placing the mouse cursor on it and clicking the left mouse button once.  The selected farm is highlighted with a coloured bar.

· Click the Join Groups button.
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Figure 42: Selecting a Group to Join. 

After identifying the farm which is to join one or more groups, you can select the group or groups you want to join by:

· Select the group by placing the mouse cursor on it and clicking the left mouse button once.  The selected group is highlighted with a coloured bar.

· Click the <Add  button to add the selected group to the list of groups you want to join.

· If you want to join all available groups, you can use the <<Add All button to automatically add all the available groups to your joining list.

· Finally click the OK button to complete your join request.
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Figure 43: Joining Groups - Making the request

That’s it.  You’ve now set up your request to join the nominated group.  The request has still not been accepted though.  That step is up to the RED SKY Farmer/Client XE "Farmer/Client Maintenance"  who maintains that group, and we’ll look at how that is done that in the next section.

5.4.4 Resigning from a Farm XE "Farm Maintenance"  Group XE "Farm Group Maintenance" 
If your farm is in a reporting Group that you no longer want to participate in, you can resign from that Group XE "Farm Groups: resigning from"  using the same Join Groups function you used to join it.

To resign from a Farm XE "Farm Maintenance"  Group XE "Farm Group Maintenance" :

· Open the Farm XE "Farm Maintenance"  Maintenance Selection List XE "Selection Lists" 
· Select the Farm XE "Farm Maintenance"  for which you want to delete the Join Group request

· Click the Join Groups button to open the Join Groups Window

· In the left-hand pane, select the Group you want to leave

· Click the Remove> button to remove that join request

· Or alternatively you can use the Remove All>> button to delete all your join requests.

· Finally click the OK button to action your remove request.

This procedure deletes your Group Membership and your request to join that group in one operation.
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Figure 44: Removing Group Members –Removing the Request to Join.
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Figure 45: Removing Group Members –Request to Join Removed.

5.4.5 Managing Group Members

5.4.5.1 Adding Members to a Group XE "Farm Groups: managing membership of: adding members" 
The owner of a Farm XE "Farm Maintenance"  Group XE "Farm Group Maintenance" - that is, the RED SKY Farmer/Client XE "Farmer/Client Maintenance"  who created it- is the only person who can add or remove farms from his group.

This is managed via the Group Maintenance function, in the same way as the farm group details are maintained.

If we now go and edit the Group our sample farm has applied to join (Figure 46 below), we can see that the applicant is now listed in the Farms Requesting to Join Group list in the right hand panel.

As the owner of the group, you approve the applicant’s request to join by:

· Selecting the applicant farm by placing the mouse cursor on it and clicking the left mouse button once.  The selected applicant is highlighted with a coloured bar.

· Click the <Add  button to add the selected applicant to your group.

· If you want to approve all applicants, you can use the <<Add All button to automatically add all the applicants listed to your group.

· Click the OK button to accept the addition to the group.
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Figure 46: Joining Groups - Approving a Request to Join
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Figure 47: Joining Groups - Applicant Approved

The applicant is approved, and if we go back to the Farm XE "Farm Maintenance"  Maintenance Join Groups window, we can see that the farm is now accepted in the selected group.
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Figure 48: Joining Groups - Applicant accepted

5.4.5.2 Releasing Reports to Group Members

Just being a member of a farm group does not automatically entitle any given Farmer/Client XE "Farmer/Client Maintenance"  to receive the group reports XE "Farm Groups: group reporting" .  As the owner of the group, you have the discretion to decide which members will get to see them and which members will not.

This function is managed from the Edit Groups Maintenance Window.  To release reports to a selected group member:

· Select the member you want to get the reports by placing the mouse cursor on it and clicking the left mouse button once.  The member is highlighted with a coloured bar.

· Click the Farmer/Client XE "Farmer/Client Maintenance"  Gets Reports checkbox. A tick will appear indicating that the selected Farmer/Client will now get the group reports.

· The Farmer/Client XE "Farmer/Client Maintenance"  Gets Reports checkbox is a toggle: clicking it again will turn off the Farmer/Client reports facility for that Farmer/Client.
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Figure 49: Releasing Group Reports to a Group Member.

5.4.5.3 Changing Farm XE "Farm Maintenance"  Group XE "Farm Group Maintenance"  Passwords.
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Figure 50: Changing Farm XE "Farm Maintenance"  Group XE "Farm Group Maintenance"  Passwords

Farm XE "Farm Maintenance"  Group XE "Farm Group Maintenance"  passwords are mandatory and  XE "Password Protection: setting & changing Farm Group passwords" 

 XE "Farm Groups: password protection of" operate just like individual Farmer/Client XE "Farmer/Client Maintenance"  passwords to protect the group’s definition and membership from unauthorised maintenance.  Once the password is set  for a particular group you have the option of having the RED SKY application remember it for you on that PC only.

To have the group password remembered XE "Password Protection: Remember Password option" , click the Remember Password on this Machine checkbox.  If  you leave this box unchecked, you will be prompted to enter the group password whenever you edit the group.

5.4.5.4 Removing Members from a Group.
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Figure 51: Removing Members from a Group

To remove members from your group XE "Farm Groups: managing membership of: removing" , you:

· Select the member you want to remove by placing the mouse cursor on it and clicking the left mouse button once.  The member to be removed is highlighted with a coloured bar.

· Use the Remove>  button to remove the selected member from your group

· Or use the Remove All>>  button to automatically remove all members from your group.  

Removing a member from your group does not delete the Request to Join that was created by the applicant in the first place.  That belongs to the applicant and it still exists.  It can only be deleted by the Farmer/Client XE "Farmer/Client Maintenance"  who created it, using the Join Groups function of the Farm XE "Farm Maintenance"  Maintenance Selection list.

 [image: image52.png]o]
&

Grow i
HotResearch
NBZ Rural Services T
NZ Racing Confererce
Foinervile Daity Farmers Association o
Fiodney Small Famers Associaion =
Thorougbred Breeders dssociation

Close

3 Edit = E

Mame: [Pointervile Dairy Famers Association
Type: Incusty Body E

Remerber Passord on this Machine [

Eams in Group Fams Requesting to Join Group
Fam Nome Farmer/Cier] Farme/Clen Gels Repats Fam Name, Famer/Clent
Fointer Hil Daity Farms Ltd___Jos Bloggs
<Add
<«<AddAl
[Hemoves |
Remove All>>
Changs Password,
0K Cancel
[
Database v.02.24.0 Paih: CAPROGAAM FILES\RED SKYADetabase\fed5ky mdb ERIEED

HAstart] | A4 € & » @ || G nbox - Microsoft O...| &3CiMy Documents\... | #Red Sky User Man... [[E3Red Sky v1.09 - .. |G e84 ~@ 2139





Figure 52: Removing Group Members – Farm XE "Farm Maintenance"  removed from group.
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Figure 53: Removing Group Members - Requesting Farm XE "Farm Maintenance"  no longer accepted.

5.5 Managing Year Data

Now we come to the main event- managing your yearly performance data XE "Year Data: definition of" .

First of all, what do we mean when we talk about “Year Data”?

Put simply, a “Year” is a short name for a collection of data that encompasses all the important details of your farm management, including

· Assets and liabilities.

· income and expenses broken down by activity and stock type,

· Cashflow, actual and predicted, 

· Your livestock, if any: how many you started the year with, and how many you finished up with, what kinds, and how much they were worth then and are worth now.

· Your inputs: usage of feedstuffs and fertilisers

· Your outputs: milk, meat and fibre production, or the yield from areas which are being cropped.

· Any additional overheads and one-off adjustments that will be shown on your annual balance sheet.

· Plus any notes that you want to keep about things you’ve entered or will need to enter into the system, and some information about the physical aspects of the farm you are entering the data for.

Once entered, Year data can be manipulated in a number of different ways.  For instance, you can:

· Compare one year against another, using the year-on-year comparison facility XE "Comparing data" ;

· Copy an entire year to use as a basis for what-if analysis

· Prepare and print a variety of reports and graphs 

All of these functions are managed using the Year Maintenance facility.

5.5.1 Year Tab Overview

The Year Maintenance Edit Windows are much more complicated XE "Year Maintenance: datasheets: overview of"  than anything we’ve looked at so far, because they handle many different kinds of data, relating to all the different aspects of your farming operations.

Let’s look first at the general layout before we dive into the details of creating and editing Year data.

When you select a year from the Year Maintenance Selection List XE "Selection Lists"  and open it by double clicking on it, or clicking on the Edit button, the first thing you will see presented to you is the Year:General Section Tab.  This is shown in Figure 54 below.
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Figure 54: Year Maintenance- Year:General Tab

The first thing to notice is the row of red tabs along the top of the screen.  These are the main sections of data XE "Year Maintenance: Sections, Categories & Sub Categories"  that you will be recording in the RED SKY application.  You can see that the General Section tab is coloured a lighter red to show that it is the currently active tab.

Otherwise the Year:General Tab shows the basic information that identifies this collection of Year data.  Some of the fields are inherited from the Farm XE "Farm Maintenance"  definition and cannot be changed on this screen: they are shown here only for information purposes.  See paragraphs 5.5.5 Creating a New Year and  5.5.7.1 The General Section Tab for details of the field contents.

5.5.2 The Typical Year Datasheet Format XE "Year Maintenance: datasheets: typical format of" 
Let’s go on now to one of the other Section tabs and see what it looks like.  

Each Section tab XE "Year Maintenance: Sections, Categories & Sub Categories"  (or data sheet) has the same general format:
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Figure 55: Year Maintenance- Tab Format

The red Section tabs are still there at the top of the window, and you can see that the Livestock Section tab is coloured a lighter red, showing that this is now the active tab.  Notice that there are two other groups of coloured tabs shown in the window:

· The orange-coloured Category tabs along the top of the window, just underneath the red Section tabs

· The yellow coloured Sub Category tabs down the left side of the window.

Again, the active category and sub category tabs are coloured a lighter orange or a lighter yellow, so it’s easy to tell where you are.  In Figure 55 above, we are looking at the Livestock Section: Category(Dairy Stock): Sub Category(Cows) datasheet.

Not all categories have sub categories: the Notes Category for instance is just a single data field where you can type in your notes in a free format, as and when you need to.

The other thing you need to know about the Category and Sub Category tabs is that they will vary depending upon which Section tab you are looking at and which production activities you have defined for your farm.  If you have only defined your production activities as Dairy and Sheep, for instance, you won’t see Beef or Other listed in the Category or Sub Category tabs as you step through the data entry process.

There four other important areas of the Data Sheet tabs that you need to know about:

· The Data Grid.
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Figure 56: Typical Tab Format – The Data Grid
Each year datasheet consists of a data grid XE "Year Maintenance: datasheets: using the data grid"  which has pre-defined headings and fields for you to enter your data into.  Fields which are open for data entry have white backgrounds.  Fields which have grey backgrounds are said to be “greyed out” and are locked off, either because the value is not appropriate or required at this time, or because RED SKY calculates the content automatically when you close the datasheet.

You can change the width of the data grid, to make it easier to read.  Just place the mouse cursor on the column boundary until it changes to (|( then hold the left mouse button down and drag the column to the width you want.
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Figure 57: Setting the Data Grid Column Widths

· The Scroll Bar
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Figure 58: Typical Tab Format – The Scroll Bar
Some of the year datasheets are too long to fit in a single window.  Slide the scroll bar XE "Scroll Bar, using the"  up and down to scan up and down through the datasheet rows.

· The Tool Tip Areas
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Figure 59: Typical Tab Format - The Tool Tip Area

RED SKY automatically provides you with a helpful tip or comment relevant to the active datasheet XE "Getting help: Tool Tips"  and fields you are working with.  This is displayed in the area at the bottom of the window, and prompts you with information about how to use this datasheet.  There are also dynamic tool tips attached to each of the data entry fields. As you rest the mouse cursor on each field heading, the appropriate tool tip will appear over the data field.  
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Figure 60: Typical Tab Format - Dynamic Tool Tips XE "Getting help: Tool Tips" 
· The Frame Controls
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Figure 61: Typical Tab Format - The Frame Controls
Lastly, at the bottom of each datasheet you will find the Frame Controls XE "Year Maintenance: Frame Controls, using the" .  These allow you to 

· preview your datasheet reports, 

· control view and update access to each datasheet individually by setting datasheet locks and/or passwords, 

· to set year-on-year comparisons, 

· and to recalculate datasheet values without closing the datasheet.  

5.5.3 Using the Frame Controls XE "Year Maintenance: Frame Controls, using the" 
5.5.3.1 The Finished Checkbox
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Figure 62: Using Frame Controls: The Finished Check Box (1) - Box Unchecked.

The Finished Checkbox is XE "Year Maintenance: Frame Controls: Finished Checkbox, using the"  an on-off toggle which shows whether data entry is finished for this datasheet or not.  Check the box ( to show the page is complete.  When the Finished checkbox is checked, a tick also appears on the associated tab to show that data entry is complete.  When all sub-categories are ticked off, the category tab is also struck through to show that it is complete.
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Figure 63: Using the Frame Controls XE "Year Maintenance: Frame Controls, using the" : The Finished Checkbox(2) - Box Checked.

5.5.3.2 The Lock/Unlock Button 
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Figure 64: Using the Frame Controls XE "Year Maintenance: Frame Controls, using the" : The Lock/Unlock Button(1) - Locking the Datasheet.

The Lock/Unlock button XE "Year Maintenance: Frame Controls: Lock/Unlock button, using the"  applies a physical lock to the current data page, preventing any changes to the data.  If the datasheet is already locked, then clicking this button will unlock it.  The Lock Status flag shows whether the lock is set for the active datasheet or not.

If you have set a password for this datasheet, then you will need to enter it into the Password Box first to enable the Lock/Unlock button.
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Figure 65: Using the Frame Controls XE "Year Maintenance: Frame Controls, using the" : The Lock/Unlock Button(2) - Unlocking the Datasheet.

5.5.3.3 The Set Password Button
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Figure 66: Using the Frame Controls XE "Year Maintenance: Frame Controls, using the" : The Set Password Button and Popup.

The Password button opens the password popup window to let you set an update password for this datasheet XE "Year Maintenance: Frame Controls: datasheet password, using the" .  When a password-protected datasheet XE "Password Protection: setting & changing Year datasheet passwords"  is locked using the Lock Button, the update password must be entered in the Password Box in order to unlock it again.

5.5.3.4 The Password Box
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Figure 67: Using the Frame Controls XE "Year Maintenance: Frame Controls, using the" : The Password Box

5.5.3.5 The Calculate Button
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RED SKY recalculates automatically when you close your data sheet, but if you need to see the effect of a calculation immediately, you can click on the Recalculate button to force recalculation XE "Year Maintenance: Frame Controls: Recalculation button, using the, effect of." 

 XE "Recalculation: using the Recalculate button"  while you wait.

While calculation is in progress, you will see a coloured status indicator moving across the bottom of the screen. 

You can also use the Options XE "System Options" :Edit Year Immediate Calculations XE "Recalculation: dynamic calculation option, effects of."  checkbox to force dynamic calculation.  However, you need to be aware that this can cause considerable delays while editing.

5.5.3.6 The Print Button
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The Print button allows you to dump the contents of the current datasheet out to a printed report XE "Year Maintenance: Frame Controls: Print button, using the" .  Clicking on the Print button opens the Print Preview pane, which lets you format your report the way you need to see it, and then print it out.

See paragraph 5.5.8 Printing Reports for a full description.

5.5.3.7 The Comparison Button
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The Comparison button opens the Comparison Year Selection popup XE "Year Maintenance: Frame Controls: Comparison button, using the" 

 XE "Comparing data: setting comparison years"  for you to choose which of the available years you will compare against the current datasheet.

See paragraph 5.5.9 Doing Year-on-Year Comparisons. for a full description.

5.5.3.8 The Close Button
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Closes the data entry page XE "Year Maintenance: Frame Controls: Close button, using the" 

 XE "Recalculation: on datasheet closure" , recalculates derived data values, and returns to the Year Maintenance Selection List XE "Selection Lists" .

5.5.4 All the King’s Horses….and Other Livestock.

In this paragraph we will take a closer look at the range of information that RED SKY can store for you.  

Table 1 lists all the Section, Category and Sub Category combinations XE "Year Maintenance: Sections, Categories & Sub Categories: combinations of" , and the diagram in Figure 68 summarizes the whole thing.  It looks a little scary, but that’s because it shows all the possible combinations of Section, Category and Sub Category.  If the farm you are recording data for has only one or two production activities, the actual number of datasheets you will need to deal with is much smaller.

Table 1: Year Data Sections, Categories & Sub Categories.

	Section
	Category
	Sub Category

	Year:General
	
	

	Year:Financial
	Notes
	

	
	Assets (Land & Buildings)
	Dairy

Sheep

Beef

Other

Total

	
	Assets (Vehicles, Plant & Other)
	Vehicles, Plant & Machinery (VPM)

Shares

Other

	
	Accounts (Long/Short)
	Assets

Liabilities

Capital Introduced

Income

Expenses

	Year:Land & Adjustments
	Notes
	

	
	Land Details (Physical)
	Physical Contour

Irrigation

Fertiliser

	
	Other Adjustments (Dairy)
	Staff

Additional Machinery Usage

Capitalised Expenses

Accelerated Depreciation

Other

	
	Other Adjustments (Sheep)
	Staff

Additional Machinery Usage

Capitalised Expenses

Accelerated Depreciation

Other

	
	Other Adjustments (Beef)
	Staff

Additional Machinery Usage

Capitalised Expenses

Accelerated Depreciation

Other

	
	Other Adjustments (Other)
	Staff

Additional Machinery Usage

Capitalised Expenses

Accelerated Depreciation

Other



	Year:Livestock
	Notes
	

	
	Dairy
	Cows

Heifers

Heifer Calves

Bulls

Other

	
	Sheep
	Ewes

Rams

Wethers

Other

	
	Beef
	Cows

Bulls

Steers

Other

	
	Other
	Females

Males

Other

	
	Production Pricing
	Dairy

Sheep

Beef

Other

	Year:Feed
	Notes
	

	
	Dairy
	Concentrates

Grass Silage

Hay

Maize Silage

Cereal Silage

Straw

By Products

Brewers Grain

	
	Sheep
	Concentrates

Grass Silage

Hay

Maize Silage

Cereal Silage

Straw

By Products

Brewers Grain

	
	Beef
	Concentrates

Grass Silage

Hay

Maize Silage

Cereal Silage

Straw

By Products

Brewers Grain

	
	Other
	Concentrates

Grass Silage

Hay

Maize Silage

Cereal Silage

Straw

By Products

Brewers Grain

	
	Dairy Calc
	Consumption

Land

Costs

	
	Sheep Calc
	Consumption

Land

Costs

	
	Beef Calc
	Consumption

Land

Costs

	
	Other Calc
	Consumption

Land

Costs



	Year:Cashflow
	Notes
	

	
	Cashflow
	Assets

Liabilities

Income

Expenses

Total

	
	Milk Production
	Manufacturing Milk Sales

Other Milk Income

	Year:Reports
	Notes
	

	
	Financial
	Dairy

Sheep

Beef

Other

Total

	
	Physical
	Dairy

Sheep

Beef

Other

	
	Operating Profit
	Dairy

Sheep

Beef

Other

Total

	
	Operating Profit/Area
	Dairy

Sheep

Beef

Other

Total

	
	Operating Profit/Stock
	Dairy Cow

Sheep SU/DSE

Beef SU/DSE

Other SU/DSE

	
	Operating Profit/Milk
	Milk Solids

Milk Fat

Litres

	
	Balance Roll
	Dairy

Sheep

Beef

Other

Total

	
	Balance Market
	Dairy

Sheep

Beef

Other

Total

	
	Charts
	Dairy

Sheep

Beef

Other

Total
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Figure 68: Red Sky Year Tabs- Sections, Categories & Sub Categories

5.5.5 Creating a New Year

Now we’ll get down to the brass tacks of actually creating a new Year XE "Year Maintenance: creating a new Year" .  First:

· Open the Year Maintenance Selection List XE "Selection Lists" , using the Year button on the Main Menu, or the CTRL-Y HotKey XE "Navigation: using the HotKeys" 

 XE "HotKey Navigation" , or the Year option on the File Menu XE "Navigation: using the File Menu" .

· Click on the New button.

[image: image73.png]# Red Sky v1.0.9 - [Year Maintenance] &

o Ele Yiew Window Help

Fam Nane.

Benchmark NZ. Fied Sky Benchmarks N2 Top 10% Daity 98/93 1389 Actual 255ep 02 0427 pm.
Fiofitable Progiess Fams  Red Sky Benchmarks  00/01 Daiiy - 2500 MS/ha 2001 Actual 275ep02 T1:48am
Fiofitable Progiess Fams  Red SkyBenchmarks  98/93 Daiiy - 1280 MS/ha 1939 Actual 08Nov 02 01:55 pm.
Fiofitable Progiess Fams ~ Red SkyBenchmarks  33/00 Daiiy - 1800 MS/ha 2000 Actual 255ep02 0422
Fiofitable Progiess Fams ~ Red Sky Benchmarks  Daiy Orly Data Test 1 2000 Budget 22Nov 02 0834 am
Test DataFamLtd Joe Bloggs Besf Only Data Test 1 202 Budget 255ep 02 D430
Test DataFam Ltd Joe Bloggs Daiy, Sheep, Beef & Dther Test Data 2002 Budget 30Dec02 11:30am

Copy.

Rollover.

Delte

Close.

Caloulation Finished 1 secs.

HAstart] | A4 € S5 B »||[EIRed Sky v1.09 - [... |ICAMy Documents\O...| B Managing Year Dat.

BRERY o ~ETD 137

W2

137





Figure 69: Creating a New Year
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Figure 70: Creating a New Year- the Year Definition Popup

When you click on the New button, the Create New Year popup XE "Year Maintenance: creating a new Year"  opens. This where you enter the most of the information which appears on the Year:General Section tab.

Some of the fields are inherited from the Farm XE "Farm Maintenance"  definition and cannot be changed on this screen: they are shown here only for information purposes.  The important fields, the ones that are specific to the Year you are working with are:

	Year Name
	An identifying name for this year’s data.  It can be anything you choose but must uniquely identify this year

	Year Number
	The year this data refers to.  This should be the year number of the financial year closing on the date of your financial year end.  If  the financial year you are entering data for ends on 31/3/2002, then the year number will be 2002.

	Farm XE "Farm Maintenance"  Owner
	The owner of the farm for which this data is being collected.  The owner must previously have been defined as a RED SKY Farmer/Client, XE "Farmer/Client Maintenance"  and is selected from a drop-down pick list

	Farm XE "Farm Maintenance"  Name
	The name of the farm for which this year data is being collected.  The farm name must previously have been defined to RED SKY  and is selected from a drop-down pick list of farms owned by the Farmer/Client XE "Farmer/Client Maintenance"  entered as the Farm XE "Farm Maintenance"  Owner.  

	Description
	A free-form description for this collection of Year Data.

	Group Tax Rate
	This defaults to whatever percentage has been set as the system tax rate, but you can override it if a different tax rate applies: for instance for a charitable or Family Trust operation.

	Actual or Budget
	This is a toggle switch indicating whether this collection of Year data represents actuals or projected budget information.



	Accounts Long or Short
	This toggle switch sets the default format for the Accounts datasheets.  Accounts Long is the recommended choice, and this is the default option.  

If you choose Accounts Long when you create the year, then all your accounting transactions are recorded at the detail level.  If you choose Accounts Short when you create the year, all your accounting transactions will only be recorded as summary totals.  You will not be able to see details of individual transactions.  The only real reason to use Accounts Short is when you are entering summarised totals from another accounting package and no detail is available anyway.

You can switch from Accounts Long to Accounts Short XE "Accounts, format of"  and vice versa during the year, but be aware that you will lose the accounts data you have already entered and will have to re-enter it in the new form.

	Farm XE "Farm Maintenance"  Area
	The farm areas shown XE "Year Maintenance: activity areas"  in this panel are inherited from the definition of the selected farm.  However, it is possible to change them for this specific collection of Year data, by clicking on the Make Editable Area Year XE "Year Maintenance: activity areas, changing the"  checkbox and then using the Edit Areas button to temporarily override the Activity areas.  The original Activity areas defined for the farm are not changed by this- to permanently alter those, you will need to use the Farm XE "Farm Maintenance"  Maintenance function. 

You can have up to 3 editable area years associated with each of  your licensed farms.  Be aware, however, that changing Year Activity areas in this way may force you to purchase an extra User License the next time you synchronise with the RED SKY server.


Once you have entered all the details which define your new year, click on the Save button to save them and create the year.  The Create New Year popup XE "Year Maintenance: creating a new Year"  closes, and you will see the new year you have just created appear in the Year Maintenance Selection List XE "Selection Lists" .  From here on, completing the new year’s data sheets is exactly the same as managing an existing year.
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Figure 71: Creating a New Year - The New Year Successfully Created.

5.5.6 Maintaining an Existing Year

Managing year data uses the same methodology whether you are entering data for a newly created year, or editing data for an existing year XE "Year Maintenance: maintaining an existing Year" .

The process is best handled sequentially XE "Year Maintenance: Sections, Categories & Sub Categories: working through" , working through the Section and Category tabs from left to right, and through each Sub Category tab on the active datasheet from top to bottom.
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Figure 72: Managing Year Data - Working Through the Tabs

As you finish entering data into each datasheet, it’s probably a good idea to check the Finished checkbox, to give a visual indication that this datasheet is complete XE "Year Maintenance: Frame Controls: Finished Checkbox, using the" , and to prevent any accidental changes.
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Figure 73: Using the Finished Checkbox to Show Completion

5.5.7 Working Though the Datasheet Tabs

This topic summarizes the contents of each Section and Category tab.

5.5.7.1 The General Section Tab
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Figure 74: Working Through the Datasheet Tabs- Year:General Section

We’ve already looked at the contents of the Year:General section XE "Year Maintenance: Sections, Categories & Sub Categories: General Section"  in paragraph 5.5.5 Creating a New Year above, so there’s only a little more to add here.

The main thing to be aware of is that if you change any of the Year:General section XE "Year Maintenance: Sections, Categories & Sub Categories: General Section"  fields,  you are changing the definition of this collection of year data, and may be required to purchase another User License as a result.  

This is especially true if you check the Make Editable Area Year XE "Year Maintenance: activity areas, changing the"  check box and alter the effective areas for this year.  

Note however that changing the effective areas here XE "Year Maintenance: activity areas, changing the"  only changes the effective areas associated with this year ~ it does not affect the area definitions specified for any other year of the same farm or the effective areas actually defined for that farm.  The areas defined for that particular farm are the inherited default values and remain unchanged unless the farm definition is itself amended.

5.5.7.2 The Financial Section XE "Year Maintenance: Sections, Categories & Sub Categories: Financial Section"  Tab

The Financial Section XE "Year Maintenance: Sections, Categories & Sub Categories: Financial Section"  categories are:

· Assets (Land & Buildings)
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Figure 75: Year: Financial Section - Assets (Land & Buildings) Category Tab.
The Assets (Land & Buildings) datasheet XE "Year Maintenance: Sections, Categories & Sub Categories: Financial Section: Assets"  is broken down into sub categories by production activity and show:

· Land areas farmed and leased at the start and end of the financial year

· Land valuations at the start and end of the financial year, and the moving average of the valuations calculated over the last 4 years.

· Assets (Vehicles, Plant & Other)
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Figure 76: Year:Financial Section, Assets (VPM) Category Tab.

This datasheet is broken down by the sub categories Vehicles & Machinery, Shares and Other XE "Year Maintenance: Sections, Categories & Sub Categories: Financial Section: Assets" , and show the valuations as at the start and end of the financial year.

· Accounts
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Figure 77: Year: Financial Section - Accounts (Long) Category Tab.
The Accounts datasheet XE "Year Maintenance: Sections, Categories & Sub Categories: Financial Section: Accounts"  shows the balance sheet figures from your annual accounts and will be shown as either Accounts Long, or Accounts Short, depending upon the setting you chose for the Accounts Long/Short option when you created this year.

5.5.7.3 The Land & Adjustments Section XE "Year Maintenance: Sections, Categories & Sub Categories: Land & Adjustments"  Tab

Under Land & Adjustments Section XE "Year Maintenance: Sections, Categories & Sub Categories: Land & Adjustments" , you enter data about

· Land Details
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Figure 78: Year: Land & Adjustments Section XE "Year Maintenance: Sections, Categories & Sub Categories: Land & Adjustments"  - Land Details Category Tab.
These datasheets record the physical aspects of the farm’s land XE "Year Maintenance: Sections, Categories & Sub Categories: Land & Adjustments: Land"  contour and rainfall.

· The Other Adjustments Category XE "Year Maintenance: Sections, Categories & Sub Categories: Land & Adjustments: Other Adjustments"  Tabs.
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Figure 79: Year:Land & Adjustments Section XE "Year Maintenance: Sections, Categories & Sub Categories: Land & Adjustments" .

There will be one or more of these datasheets, depending upon the production activities you have selected for this farm and year.  Each datasheet records

· Additional staff costs attributable to the selected of the production activity.

· Additional machinery and plant usage costs attributable to the selected of the production activity.

· Capitalised expenses attributable to the selected of the production activity.

· Accelerated depreciation attributable to each of the production activities defined for this farm

· Any other balance sheet adjustments appropriate to the selected of the production activity.

Figure 79 above shows the Other Adjustments(Dairy) Category tab as an example.

5.5.7.4 The Livestock Section Tab

The categories of the Livestock Section XE "Year Maintenance: Sections, Categories & Sub Categories: Livestock"  are:

· The Stock Type XE "Livestock: tracking different types of"  Categories Tabs
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Figure 80: Working Through the Datasheet Tabs - Year:Livestock Section, Stock Type XE "Livestock: tracking different types of"  Tabs.

The Livestock Section, Stock Type XE "Livestock: tracking different types of"  Categories XE "Year Maintenance: Sections, Categories & Sub Categories: Livestock: Stock Types"  tabs record details of your livestock herds.

There is one Stock Type XE "Livestock: tracking different types of"  Category tab for each of the production activities defined for the farm you are entering data against. Figure 80 above shows the format of the Stock Type datasheet.

Each Stock Type XE "Livestock: tracking different types of"  Category tab is broken down into Sub Categories by the animal types appropriate for that Category;

· Dairy Category ~ 

Cows, Heifers, Heifer Calves and Bulls 

· Sheep Category ~ 

Ewes, Rams, and Wethers  

· Beef Category ~ 

Cows, Bulls and Steers 

· Other Stock Category ~ 
Males and Females.

· The Livestock Section,  Production Pricing Category tab 
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Figure 81: Year:Livestock Section , Production Pricing Category Tab.

This datasheet stores details of the output volumes of, and current prices XE "Year Maintenance: Sections, Categories & Sub Categories: Livestock: Production Pricing"  for, the milk, meat, fibre or other products deriving from your activities.  These values are used for calculating expected returns.  Figure 81 above shows the format of the Production Pricing datasheet.

5.5.7.5 The Feed Section Tab

The Feed Section tab holds details XE "Year Maintenance: Sections, Categories & Sub Categories: Feed usage"  of the feedstuffs you use and what the consumption rates were.  Both usage and consumption are broken down by stock type XE "Feedstuffs: usage by stock type" .

· The Stock Type XE "Livestock: tracking different types of"  Category Tabs 
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Figure 82: Year:Feed Section, Stock Type XE "Livestock: tracking different types of"  Category XE "Year Maintenance: Sections, Categories & Sub Categories: Feed usage: Stock Types"  Tabs.

You can track eight different types of feedstuffs XE "Feedstuffs: usage by feed type"  and consumables for each of your selected production activities.  Figure 82 above shows the format of the Stock Type XE "Livestock: tracking different types of"  datasheets.

· The Calc Type Category Tabs 
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Figure 83: Working Through the Datasheet Tabs – Year:Feed Section, Calc Category Tabs

These datasheets record information about feed consumption, land usage for feed cropping and forage, and the associated feed or forage costs.  This is used to calculate the cost per stock unit of feeding your animals XE "Year Maintenance: Sections, Categories & Sub Categories: Feed usage: cost per stock unit" 

 XE "Livestock: tracking different types of" 

 XE "Feedstuffs: consumption rates by stock type"  through the year.  Figure 83 above shows the format of the Feed Section, Calc Stock Category tab.

5.5.7.6 The Cashflow Section XE "Year Maintenance: Sections, Categories & Sub Categories: Cashflow recording"  Tab

The Cashflow Section XE "Year Maintenance: Sections, Categories & Sub Categories: Cashflow recording"  allows you to track your assets, liabilities, incomes and expenditures over time, and predict when future income will be paid and expenses will fall due.

· The Tax Settings Category Tab
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Figure 84: Year: Cashflow Section - Tax Settings Category Tab.
This datasheet records when your income or company and GST or consumption taxes will fall due XE "Year Maintenance: Sections, Categories & Sub Categories: Cashflow recording: Tax Schedules"  and what the tax amounts to be paid or refunds to be received will be.

· The Milk Production Category Tab
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Figure 85: Year: Cashflow Section - Milk Production Category Tab.
This category only appears in the Cashflow Section when Dairy XE "Year Maintenance: Sections, Categories & Sub Categories: Cashflow recording: Milk Production"  is selected as a production activity for this farm and year. This tab records information month by month about the annual milk production and the prices paid for it.

· The Cashflow Category tab 
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Figure 86: Year:Cashflow Section, Cashflow Category Tab.

This tab is a cashflow datasheet XE "Year Maintenance: Sections, Categories & Sub Categories: Cashflow recording: cashflow spreadsheet"  which allows you to record the details of your monthly balance sheet and predict when specific income and expenses will fall due.  

5.5.7.7 The Reports Section Tab

The Reports section tab XE "Year Maintenance: Sections, Categories & Sub Categories: Reports"  opens up the full power of  RED SKY’s performance reporting but it is not activated until you have purchased the necessary user license XE "Synchronisation & Licensing: User Licenses, requirements for, purchasing of" s and synchronised your data for consolidation and report calculation.  

There are several categories of pre-formatted reports and charts available.

· Financials 

these reports show the usual balance sheet divisions XE "Year Maintenance: Sections, Categories & Sub Categories: Reports: Financial reporting"  of Assets and Liabilities, and the Profit & Loss statement for the year to date, broken down by production activity.

[image: image91.png]BALANCE SHEET ASSESSMENT

Total Assets al End of Year - Market Value

Total Assets at End of Year - 4Year Roling Average Value

Total Liabiifis at End of Year

EQUITY at Market Values

Change i Equiy at Market Values

EQUITY % ot Matket Values

EQUITY at 4-Year Rolling Average Values

Changs in Equity at 4ea1 Roling Average Vales

EQUITY % 4Year Rolling Average

Addiional Value Created

PROFIT & LOSS FOR YEAR

Gross Farm Incame.

Gross Farm Expenses

OPERATING PROFIT/(LOSS)

Operating Frofi/[Loss] per Area

FETURN DN ASSETS (ROA) at Market Values.

ROA at 4-Year Rolling Average Values

Capial Efficency (Asset Tumaver Raio) at #Year Roling
Average Values

Frofi/[Loss) including Capital Gain at Market Values.

Frofit/[Loss) including Capital Gain at 4-Year Roling Average
Values.

RN il Pt G b 4o el s Vs

$2926541
$3,009.950
$1,50,000
$1.376.541
$74500)
4720%
$1.459,950
$158,008
485%
71%]

$642852
$353105
$283.757
$28%
99%]
9%
25%
$318757
$ 402165
141

oo || @

]

Database v.0.2.24.0 Path: C:\PROGRAM FILES\RED SKY\Database\RedSkymds

Bstart| | A @ S ™ *||[EIRed Sky v1.09 [.. ‘2ICiMy DocumentsiO.

] Managing Vear Dat.

[ wnam [z

|BEHE S@ -HTTR 1427




Figure 87: Year: Reports Section - Financials Category Tab.

· Physical

The physical reports summarise XE "Year Maintenance: Sections, Categories & Sub Categories: Reports: Physical reporting"  your productivity and consumables usage by production activity.
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Figure 88: Year: Reports Section - Physical Category Tab

· Operating Profit
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Figure 89: Year:Reports Section - Operating Profit Category Tab.

The Operating Profit report XE "Year Maintenance: Sections, Categories & Sub Categories: Reports: Operating Profit reporting"  shows your income, expenses and adjustments, and summarises the values to give an overall operating profit or loss figure for the selected production activity.

· Operating Profit by Area
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Figure 90: Year: Reports Section - Operating Profit by Area Category Tab.

This report shows the same profit and loss information as the overall report, but the figures are shown per unit area used for the production activity XE "Year Maintenance: Sections, Categories & Sub Categories: Reports: Operating Profit reporting"  you are reporting on.

· Operating Profit by Stock Unit
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Figure 91: Year: Report Section - Operating Profit by Stock Unit Tab.
This report shows the same profit and loss information as the overall report, but the figures are shown per stock unit for the production activity XE "Year Maintenance: Sections, Categories & Sub Categories: Reports: Operating Profit reporting"  you are reporting on.

· Operating Profit by Milk Production Unit
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Figure 92: Year: Report Section - Operating Profit by Milk Production Category Tab.
This report shows the same profit and loss information as the overall report, but the figures are shown per Milk production unit XE "Year Maintenance: Sections, Categories & Sub Categories: Reports: Operating Profit reporting" .  This report is only available for Dairy operations.

· Balance Sheet (Rolling)
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Figure 93: Year: Report Section - Balance Sheet (Rolling) Category Tab.
This report shows the current balance sheet position year-to-date XE "Year Maintenance: Sections, Categories & Sub Categories: Reports: Balance sheets" .

· Balance Sheet (At current Market values)
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Figure 94: Year: Reports Section - Balance Sheet (Market Value) Category Tab.
This report shows the current month balance sheet position at current market valuation XE "Year Maintenance: Sections, Categories & Sub Categories: Reports: Balance sheets" .

· Charts
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Figure 95: Year: Reports Section - Charts Category Tab.

The Charts category XE "Year Maintenance: Sections, Categories & Sub Categories: Reports: Charts"  presents the various reports discussed here in chart format.

5.5.8 Printing Reports

[image: image100.png]i<

12 slw Q|- | s

Financial Farm Performance - Dairy

Red Sky Benchmarks
Profitable Progress Farms

BALANCE SHEET ASSESSMENT

Total Assets at End of Year - Market
Value

Total Assets at End of Year - 4-Year
Rolling Average Value

Total Liabilties at End of Year
EQUITY at Market Values

Change in Equity at Market Values
EQUITY % at Market Values

EQUITY at 4-Year Rolling Average
Values

Change in Equity at 4-Year Rolling
Average Values

EQUITY % 4 Year Rolling Average
Additional Value Created

PROFIT & LOSS FOR YEAR
Gross Farm Income

Gross Farm Expenses
OPERATING PROFITALOSS)
Operating Profiti(Loss) per Area

RETURN ON ASSETS (ROA) at
Market Values

ROA at 4 Year Rolling Average
Values

Capital Efficiency (Asset Turnover
Ratio) at 4- Year Roling Average

Dairy Only
Data Test1

§2926541
§3,009950

§ 1,550 000
§1376541
§74600
70%
$1,459 950

§ 158009
485%

7%

§ 64262
§359105
$ 283757
$2638
99%

99%

25%

- Margins
Lt
Right  f——
Top  —— —
Header ——— f——
Botom — |
Footer —

~Row and Column Spacing—

Desciption  f————

Data —a

—
Flow Height —— }—

-Fonts. Borders, Colours —
Page Border ——

Nare g
DataBoder ——

hane. g

Select Colours
Select Font

I |

- Options

T Summary Orly
T~ Show Margins
T~ lign Data Columns Right





Figure 96: Printing Reports - The Report Preview Window.
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 The Print Button Frame Control XE "Year Maintenance: Frame Controls: Print button, using the"   appears on every Section tab except the General Tab and is the mechanism for previewing and printing local reports out of the RED SKY application.

When you click on the Print Button, the Report Preview window opens.  Down the right-hand side of the pane there are a number of Format Control sliders and options which allow you to format the report in the way that you want to see it XE "Printing reports: changing report format" .

When you are happy with the results, you can click the Print button at the top of the pane to print the report out on your printer XE "Printing reports" .  This will usually be the default system printer, but if you need to send the report to a different printer XE "Printing reports: changing printer setup" , you can use the Setup button to change the printer properties for this report.

There is a difference between the datasheet reports XE "Printing reports: Print button vs Report tab"  you print using the Frame Control Print button and the reports provided to you by the Year:Report section tab:

· Print button reports only show the data from your Year datasheets- the data held in your own local database XE "Database: Local database" .

· The Year:Report section tab shows you the consolidated performance reports created for you by the RED SKY Server XE "Server"  reporting module.  These are not available until you have subscribed to the server by doing a synchronise and purchasing your user license XE "Synchronisation & Licensing: User Licenses, requirements for, purchasing of" (s).

5.5.9 Doing Year-on-Year Comparisons.

5.5.9.1 Setting Comparison Years.
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Figure 97: Setting Comparison Years

Sometimes you need to measure how your operation is performing this year, against other years and maybe against other farms, or against a pre-set budget year.

RED SKY handles this by allowing you to choose one or more Comparison Years, which will be displayed beside your current year data on the Year Maintenance datasheets.

To set a comparison year XE "Comparing data: setting comparison years" , you

· Click on the Frame Control Comparison Button to open the Comparison Year Selection popup XE "Year Maintenance: Frame Controls: Comparison button, using the" 

 XE "Comparing data: setting comparison years" .

· Select the year or years you want to use for comparison from the list of available comparison years and click the ADD> or ADD ALL>> button to add that year or years to the list of selected comparison years.

· Click the Ok  button to close the Comparison Year Selection popup XE "Year Maintenance: Frame Controls: Comparison button, using the" 

 XE "Comparing data: setting comparison years" .

Your selected comparison years will now be displayed alongside the current year’s data in all of the datasheets.

Comparison year data cannot be altered by editing it in the current open year.  If you want or need to change it, you will have to select the comparison year from the Year Maintenance Selection list and edit it in the normal way.  Your changes will then automatically be displayed wherever that year is used for comparisons.
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Figure 98: Setting Comparison Years – The Comparison Year Selection Popup
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Figure 99: Setting Comparison Years - Comparison Year Selected.
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Figure 100: Setting Comparison Years – Selected Comparison Year Displayed on Datasheet

5.5.9.2 Removing Comparison Years

To remove a comparison year XE "Comparing data: removing comparison years" , you

· Click on the Frame Control Comparison Button to open the Comparison Year Selection popup XE "Year Maintenance: Frame Controls: Comparison button, using the" 

 XE "Comparing data: setting comparison years" .

· Select the year or years you want to use for comparison from the list of available comparison years and click the <Remove or <<Remove All button to remove that year or years from the list of selected comparison years.

· Click the Ok  button to close the Comparison Year Selection popup XE "Year Maintenance: Frame Controls: Comparison button, using the" 

 XE "Comparing data: setting comparison years" .

The comparison year or years will now be removed from the current year’s datasheets.

5.5.10 Copying Year Data

Sometimes you need to create a copy of an existing year’s data XE "Copying Year data" .  This is very useful if you want to change some aspects of the year for what-if analysis, or perhaps set up a budget scenario for comparison purposes.

To create a copy year XE "Year Data: copying of" , simply

· Select the year you want to copy from the Year Maintenance Selection List XE "Selection Lists" 
· Click the Copy button
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Figure 101: Copying Years

You will be presented with the Copy Year popup window.  This identifies and confirms the year you have chosen to copy by displaying the General Section details of the selected year in a similar way to when you create a new year.  Figure 102 below shows the Copy Year Popup window.

You cannot change the general fields at this stage- you can only decide to cancel the copy or continue by clicking on the Copy button.
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Figure 102: Copying Years: The Copy Year Popup.

You will then be prompted to confirm the copy.  Clicking the Yes button completes the copy operation, and you will see the copy year appear in the Year Maintenance Selection List XE "Selection Lists" 
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You can then edit the copy year and change its details as necessary for your purpose.
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Figure 103: Copying Years - Copy Year Successfully Created.

One thing to note about the copy process is that the new copy is completely independent of the original ~ changing the original year data does not affect the copy year in any way.

5.5.11 Year Rollover

At the end of each financial year, RED SKY  it is usual to close off the Year XE "Year Maintenance: Rollover, closing off" 

 XE "Closing Years- see Year Maintenance: Rollover"  Section datasheets for your performance data.  This process is known as “Rollover”, and it uses the closing balances from the year you have selected for rollover to automatically create opening balances for the next financial year.

To close off, or “roll over” a selected year XE "Year Maintenance: Rollover, closing off" 
· Select the year to be rolled over from the Year Maintenance Selection List XE "Selection Lists" 
· Click the Rollover button to begin the roll over process.
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Figure 104: End of Year Rollover

You will be presented with the Rollover Year popup window.  This identifies and confirms the year you have chosen to roll over by displaying the General Section details of the selected year in a similar way to when you create a new year.  Figure 105 above shows the Rollover Year Popup window.

You cannot change the general fields at this stage- you can only decide to cancel the rollover operation or continue by clicking on the Rollover button.
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Figure 105: The Year Rollover Popup

After you have confirmed the Rollover operation, you will be presented with the Rollover Scaling popup. XE "Year Maintenance: Rollover, closing off: changing area and/or stock numbers"   

This popup window allows you the optional to increase or decrease the area and/or stock numbers that will be used for the new year’s calculations, either by a nominal value or by a percentage amount. 
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Figure 106: End of Year Rollover - Applying Scaling.

RED SKY then takes the scaled area and stock levels and recalculates the new year.  You will see the coloured calculation progress indicator bar appear at bottom of the screen while this is in progress.  The year number is automatically updated to the next financial year, and the rollover year appears in the Year Maintenance Selection List XE "Selection Lists" .
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Figure 107: Year End Rollover - Calculation in Progress.
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Figure 108: End of Year Rollover - Rollover Complete.

One thing to note about the Rollover process is that once the opening balances are calculated for the new rollover year, changing the original year data will not alter them in any way.

5.6 Deleting Data

Deleting any of your data is an action XE "Deleting data"  that requires a certain amount of caution- best summed up by the phrase “when it’s gone, it’s gone!”

For this reason, all of the delete controls XE "Deleting data: confirming the"  in the RED SKY application require you to confirm your action not once but twice before the requested deletion is actually performed.  This gives you the opportunity to change your mind along the way….

However, when you do delete data from the RED SKY database XE "Database" , it is only removed from your own local copy of the database- anything that has been synchronised to the RED SKY Server XE “Server”  is retained unchanged in the server database XE "Databases Server database" 

 XE "Database: Server database"  until the server itself is periodically archived, and could therefore be retrieved from there using the Retrieve Client facility described in Section 5.2.4 above
The other thing you need to understand about deletion is that the scope of the delete action XE "Deleting data: scope of"  (i.e. what is deleted) varies depending upon where you actually request it.  

This is because of the implicit relationships between XE "Database: Relationships"  Farmer/Client XE "Farmer/Client Maintenance" s, Farms and Years.  Let’s take look at our basic building blocks again XE "Database: Building Blocks" :
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Figure 109: RED SKY Building Blocks XE "Database: Building Blocks" 
Ignoring the Reference Data, which is maintained by RED SKY and updated automatically during Synchronisation XE "Refreshing reference data" , and the Groups, which we will talk about in a moment, let’s take a look at the relationships between XE "Database: Relationships"  

· Farmer/Client XE "Farmer/Client Maintenance" s

· Farms

· Years

This is what is called a Parent/Child relationship XE "Database: Relationships" : that is to say, Years cannot exist unless there are Farms to attach them to, and Farms must likewise have a Farmer/Client XE "Farmer/Client Maintenance"  to own them.

With that in mind, consider the mechanics of deletion:

· If you request the deletion of a single Year, that is all you will delete- that year and nothing else.

· However, if you request the deletion of a Farm XE "Farm Maintenance" , because of the Parent/Child relationship XE "Database: Relationships"  between that Farm and all its dependent Years, all of those dependent Years must also be deleted before the Farm itself is removed.
· Similarly, if you requested the deletion of a particular Farmer/Client XE "Farmer/Client Maintenance" , then again, because of the Parent/Child relationship XE "Database: Relationships" s between the Farmer/Client and his dependent Farms (and the dependent Years associated with those farms), then all of those dependents must first be deleted before the Farmer/Client is removed.
It’s a little like pruning a tree- you can take off a single twig- a Year;  or an entire branch- a Farm XE "Farm Maintenance" ; or you can go the whole hog and chainsaw the thing off at ground level by taking out the Farmer/Client XE "Farmer/Client Maintenance" .

This concept is known as Cascade XE "Window Menu: Cascade windows"  Deletion XE "Deleting Data: Cascade Deletion" , and you needn’t worry about it any further than that, because the RED SKY application has been built to automatically check for these conditions and take the necessary action for you in each case.  

Deleting Groups is a little different.  To delete a Group, all its memberships must have been removed first, by editing the Group and doing a Remove All.  Only then can the Group itself be deleted.  The participating Farms are not touched in any way, though, because that, in turn, would cause the deletion of dependent Year data - which you probably want to keep!  

Oh, and one other thing: before you can perform any maintenance on either Farmer/Client XE "Farmer/Client Maintenance"  or Group definitions (or Farms and Years associated with them) you must give the appropriate passwords. XE "Password Protection: Deleting data"   If the Remember Password XE "Password Protection: Remember Password option"  boxes were not checked when the Farmer/Clients or Groups were created, then you will be prompted to give the login password before RED SKY will allow you to continue.  If the Remember Password boxes were checked then RED SKY recovers the passwords from its own memory and assumes you are authorised to go ahead.

Let’s go now and look at how we actually delete some data.

5.6.1 Deleting Year Data
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Figure 110: Deleting Year Data

You delete a single Year XE "Deleting data: deleting a year" , with all of its details by selecting the year from the Year Maintenance Selection List XE "Selection Lists"  and clicking the Delete button.  You will then be shown the Year definition window to confirm that this is the one that you really want to delete.  Click the Delete button on this panel to confirm your deletion as shown in Figure 111 below.
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Figure 111: Deleting Year Data – Confirming the Delete (1)

Having done that, RED SKY offers you one more chance to change your mind….
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Figure 112: Deleting Year Data - Confirming the Delete(2)

If you click the Yes button here, then acting on the Snark Principle XE "Deleting data: Snark Principle, the"  (“What I tell you three times XE "Snark Principle, the- see Deleting Data"  is true XE "Snark Principle, definition of" !”), the Year you selected will be deleted from your local database XE "Database: Local database" .  If the Year is a large one, this may take some time and you will see the Delete In Progress popup (Figure 113 below) while it is all happening.  No, on the other hand, cancels the delete operation and leaves your data untouched.

While we are looking at this, note also that Yes is the default option here and will be actioned if you should chance to press the Enter key about this time.
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Figure 113: Deleting Year Data ~ Delete in Progress Popup
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Figure 114: Deleting Year Data(3) ~ Selected Year Deleted.

5.6.2 Deleting Farm XE "Farm Maintenance"  Details
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Figure 115: Deleting Farm XE "Farm Maintenance"  Details

Deleting a Farm definition XE "Deleting data: deleting a farm"  is very similar to deleting a single year.  First select the farm that you want to delete from the Farm XE "Farm Maintenance"  Maintenance Selection List XE "Selection Lists" , then click on the Delete button to begin the process.
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Figure 116: Deleting Farm XE "Farm Maintenance"  Details ~ Farm Details Confirmation

RED SKY brings up the Farm XE "Farm Maintenance"  details window so you can confirm that this farm really is the one you want to delete.  Click on the Delete button to confirm, or Cancel to exit the delete process.
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Figure 117: Deleting Farm XE "Farm Maintenance"  Details ~ Confirm the Delete

Again, acting on the Snark Principle XE "Deleting data: Snark Principle, the" , RED SKY prompts you to confirm your delete request a third time.  Click  the Yes button to go ahead and delete this farm and all of its dependent years.  Clicking the No button abandons the delete operation and leaves the farm and year data unchanged.

Note that Yes is the default option here and will be actioned if you should chance to press the Enter key about this time.

If the Farm has many dependent Years, this may take some time and you will see the Delete In Progress popup while it is happening.
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Figure 118: Deleting Farm XE "Farm Maintenance"  Details ~ Farm Successfully Deleted
5.6.3 Deleting Farmer/Client XE "Farmer/Client Maintenance"  Details

Deleting a Farmer/Client XE "Deleting data: deleting a Farmer/Client" 

 XE "Farmer/Client Maintenance"  from the RED SKY database XE "Database"  follows the same pattern as deleting years and farms.
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Figure 119: Deleting Farmer/Client XE "Farmer/Client Maintenance"  Details

RED SKY brings up the Farmer/Client XE "Farmer/Client Maintenance"  details window so you can confirm that this really is the one you want to delete.  Click on the Delete button to confirm, or Cancel to exit the delete process.
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Figure 120: Deleting Farmer/Client XE "Farmer/Client Maintenance"  Details ~ Farmer/Client Confirmation
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Figure 121: Deleting Farmer/Client XE "Farmer/Client Maintenance" s ~ Confirming the Delete

Once again the Snark Principle XE "Deleting data: Snark Principle, the"  comes into play and RED SKY prompts you to confirm your delete request a third time.  Click  the Yes button to go ahead and delete this farmer/client and all of its dependent farms and years.  Clicking the No button abandons the delete operation and leaves the farmer/client, farm and year data unchanged.

Note that Yes is the default option here and will be actioned if you should chance to press the Enter key about this time.

5.6.4 Deleting Groups

Now we come to deleting Groups XE "Deleting data: deleting a Group" .  When you delete a Group, you must first remove the group memberships by editing the group and clicking on the Remove All>> button.  
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Figure 122: Deleting a Group

RED SKY brings up the Group details window so you can confirm that this really is the one you want to delete.  Click on the Delete button to confirm, or Cancel to exit the delete process.
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Figure 123: Deleting a Group ~ Group Details Confirmation
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Figure 124: Deleting a Group ~ Confirming the Delete

Under the Snark Principle XE "Deleting data: Snark Principle, the" , RED SKY once again prompts you to confirm your delete request a third time.  Click  the Yes button to go ahead and delete this group and all of its dependent memberships.  Clicking the No button abandons the delete operation and leaves the group and membership data unchanged.

Note that Yes is the default option here and will be actioned if you should chance to press the Enter key about this time.

5.7 Synchronisation

Synchronisation is the process XE "Synchronisation & Licensing"  whereby data from the local or client database~ your data~ is uploaded to the RED SKY Server XE "Server"  for reporting purposes.

It’s important to remember here the difference between the reports XE "Printing reports: Print button vs Report tab"  you print using the Frame Control Print button and the reports provided to you by the Year:Report section tab:

· Print button reports only show the data from your Year datasheets- the data held in your own local database XE "Database: Local database" .

· The Year:Report section tab shows you the consolidated performance reports created for you by the RED SKY Server XE "Server"  reporting module.  These are not available until you have subscribed to the server by doing a synchronise and purchasing your user license XE "Synchronisation & Licensing: User Licenses, requirements for, purchasing of" (s).

Synchronisation is also the mechanism whereby you can share benchmark data against which to measure the performance of your own operations.

Synchronisation is a two-way process: your data is not only uploaded to the RED SKY Server XE "Refreshing reference data" 

 XE "Server" , but your local copy of the RED SKY reference data may be refreshed during synchronisation by a new version copied to your local database XE "Database: Local database"  from the RED SKY Server.  

5.7.1 Starting the Synchronisation

To begin a data synchronisation XE "Synchronisation: launching of" , launch the Synchronise process by

· Clicking on the Synchronise button on the Main Menu, or,

· Selecting the Synchronise with Server XE "Synchronisation & Licensing" 

 XE "Server"  option from the File Menu XE "Navigation: using the File Menu" , or

· Using the CTRL-S HotKey XE "Navigation: using the HotKeys" 

 XE "HotKey Navigation"  
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Figure 125: Launching Synchronise from the Main Menu

5.7.2 Managing User Licenses

Part of the normal synchronisation process involves the checking of your user license XE "Synchronisation & Licensing: User Licenses, requirements for, purchasing of"  or licenses, and if these are not current, then synchronisation will not proceed until you have re-subscribed.

Each farm to be reported on by RED SKY requires at least one user license XE "Synchronisation & Licensing: User Licenses, requirements for, purchasing of" . Each licensed farm can list as many non-editable Years for synchronisation and reporting as you want, and up to 3 Editable Area Years as well.  If you have more than 3 Editable Area Years XE "Editable Areas: effect on licenses" , then you will need to purchase at least one extra user license for that farm.
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Figure 126: Synchronisation ~ Selecting Licenses for Purchase

The first step of the synchronisation process checks whether the farms you have defined in your local database XE "Database: Local database"  have current user license XE "Synchronisation & Licensing: User Licenses, requirements for, purchasing of" s.  If  you have farms with no current licenses XE "Managing User Licenses" , or the you have a farm which has more than 3 Years with editable areas XE "Editable Areas" , the RED SKY application will prompt you to purchase the extra licenses you need.

The RED SKY application makes this easy for you by showing you a list of the farms you have defined in your local database, with the Purchase box ticked for those which need licenses XE "Database: Local database" .  Untick any that you don’t want by simply clicking on the Purchase checkbox with the left mouse button, and then click the Ok button to continue.  Alternatively, you can abandon the synchronise altogether by clicking the Cancel button.

If  you already have the appropriate user license XE "Synchronisation & Licensing: User Licenses, requirements for, purchasing of" s, this step is skipped and the synchronisation selection panel (Figure 127 below) appears. 

 XE "Synchronisation & Licensing: User Licenses, requirements for, purchasing of" 
5.7.3 Synchronising the Application Data

The next step in the Synchronisation process is to select the Farms and Years that you want to synchronise with the RED SKY Server XE "Server" .  

The RED SKY application makes this easy for you by showing you a list of the Farms and Years you have in your local database, with a tick in the Calculate? checkbox against those which are eligible for calculation XE "Database: Local database" .  Untick any that you don’t want to synchronise by simply clicking on the Calculate? checkbox with the left mouse button, and then click the Ok button to continue.  Alternatively, you can abandon the synchronise at this point by clicking the Cancel button..
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Figure 127: Synchronisation ~ Selecting the Years to Synchronise

Next, your local copy of the RED SKY application has to connect to the RED SKY Server XE "Server"  via the Internet.  You will be prompted to confirm the connection by clicking the Ok button to continue.  Alternatively, you can abandon the synchronise at this point by clicking the Cancel button..
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Figure 128: Synchronisation ~ Connecting to the Internet

Synchronisation is a two step process:

· Refreshing the RED SKY  application reference data XE "Database: application reference data"  from the RED SKY Server XE "Server"  to your local database XE "Database: Local database" .

· Updating the RED SKY Server XE "Server"  with Farmer/Client XE "Farmer/Client Maintenance" , Farm XE "Farm Maintenance" , Farm Group XE "Farm Group Maintenance"  and Year data from your local database XE "Database: Local database" .

Each step displays a confirmatory popup which shows how the synchronise process is progressing, and both steps must complete for a successful synchronisation.

The first step- downloading refreshed reference data- is relatively quick.  The second step- uploading your data for synchronisation- can take quite a while, especially if you are synchronising a lot of Farms and/or Years at once.  

5.7.4  Updating Reference Data Only

Sometimes you may want or need just to update the RED SKY reference data without necessarily doing a full synchronise of your own data.

This function is handled from the File Menu XE "Navigation: using the File Menu" , using the Refresh Static Data XE "Refreshing Static Data"  option.  Selecting this option launches a mini-synchronise which connects to the RED SKY Server XE "Server"  via the Internet and downloads a new copy of the reference data set to your local database XE "Database: Local database" .  

6 ABC’s – Archiving, Backing Up, and Compressing Data

6.1 Archiving vs Deleting Data.

The RED SKY Application has no built-in facility for archiving historical data XE "Archiving" : that is, transferring less-referenced historical data to secondary storage such as removable disk or CD media.  However, the process of Synchronisation does allow something XE "Archiving: effect of synchronisation"  of this sort to be achieved.

When you synchronise the data on your local version of the RED SKY database XE "Database"  with the RED SKY Server XE “Server” , a snapshot is taken of all your current data and uploaded to the server database XE "Databases Server database" 

 XE "Database: Server database" , where it will be retained for a period, even though you may have deleted it from your own local database XE "Database: Local database"  in the mean time.  As long as your data exists on the server database, you can retrieve it again using the Retrieve User function described XE "Retrieving a predefined user" 

 XE "Farmer/Client: retrieving predefined"  in topic  5.2.4 Retrieving a Predefined Farmer/Client XE "Farmer/Client Maintenance"  above.

The length of time your data will be retained on the RED SKY Server XE “Server”  will depend upon the size of the data storage media available to the server and the combined activity of yourself and other users.

6.2 Backing Up

And now for the TEN COMMANDMENTS of PC XE "Backups: importance of" :
1. Back up your data every time you update it.

2. Back up your data every time you update it.

3. Back up your data every time you update it.

4. Back up your data every time you update it.

5. Back up your data every time you update it.

6. Back up your data every time you update it.

7. Back up your data every time you update it.

8. Back up your data every time you update it.

9. Back up your data every time you update it.

10. Back up your data every time you update it.

Nothing hard about that, is there?  But how often we all as computer users don’t bother with removable backups  (Hands up who skips ‘em!).  After all, it is a bit of a nuisance to have to get another floppy or zip disk out of the cupboard, or load another tape.

Probably nine computer crashes (virus attacks included) out of ten, you may not need your backup, BUT (and it’s a big but!) the tenth time you’ll be really, REALLY glad your backups were up to date when you or your support technician has to rebuild your computer system from the ground up, because you had a catastrophic virus attack or your hard disk died.

And of course, the best place to store your removable backups XE "Backups: storage of"  is in a fireproof cupboard, or even better still, in a fireproof cupboard in another building.  This is known as off-site storage.

6.3 Compressing Your Database

As your data builds up over time, you may find that you are running out of space for the local database XE "Database: space problems with, compression of" 

 XE "Database: Local database"  on your hard drive.  You may also notice that the response from RED SKY is getting slower XE "Response times, slowing of"  and slower.

When this happens you can delete some of your older or unwanted years, or use the database compression option XE "Database: Compression options" , which you will find on the Options XE "System Options"  window.  You can open the Options window either by clicking on the Options button of the Main Menu, or by selecting Options from the drop down View menu.

[image: image135.png]9 Red Sky v0.2.52 1] L) || | 21| &7 | )| 88} | 1] 2

Eie View Window Help

T
Genel |Edor] Coston]

[ Show Splash Screen

I~ Compress DB on Ext Adrin Mode.

] D el

Server = [RedSky
Database = [\DatabaseFedsky mdb
UserID = Fredsklser

Password =

LogoFileName:  [Nmages\Logo2 bmp

LogoFieSize:  [100 | %

& Acsess €190l Gene

e [2155
{59) RedRed Sl User Manual 203 doc Mictosoft Word] 55

Caloulatian Finished 4 secs.

HAstart] | A4 € 51 7|

Inbox - Microsoft O... | (=3 C:\My Documents\O...|[E2 Red Sky v0.2.52





Figure 129: Database Compression Option

Click on the Database Compression checkbox to activate data compression.  You may find that the RED SKY Application takes slightly longer to open and close the database but it will take up less space on your hard drive.

In any case, even with compression, you should probably think about deleting some of your older years or alternative scenario years which may no longer be useful.

Glossary of Terms

	Client Computer
	An individual user’s desktop or notebook computer which supports the user’s desktop applications such as MS Word, MS Excel, E-mail and Internet connections.  

	Client Pack
	The part of the RED SKY application which resides on the application user’s computer and manages the local database XE "Database: Local database" 

	Client/Server XE "Client/Server" 

 XE "Server" 
	A computer application which has two parts, a front-end Client and a back-room Server, XE "Server"  which both work together to achieve the desired result.  See also Client Pack, Server Pack.

	CPU 
	The actual processor or “brainbox” of a computer.  The speed rating in Hertz (Hz) or MegaHertz (MHz) indicates how fast the computer runs.

	Server XE "Server" 
	The RED SKY file server XE “Server”  on which the server database XE "Databases Server database" 

 XE "Database: Server database"  resides

	File Server XE "Server" 
Remote Server XE "Server" 
	A large, powerful computer which is used as to store large databases from which client computers can retrieve data on demand.  File servers can be located anywhere, from simply on the other side of the room to maybe on the other side of the world from the client.  File Servers can also be known as Remote Servers.

	Database
	A file or group of files which are used to store data in the form needed for a particular purpose.

	Gigabyte (Gb)
	A measure of computer memory size or storage capacity, equal to 1,000,000 Kb.  Hard disk storage capacity is typically  measured in Gb.

	Hard Disk
	The main data storage unit used by most computers

	Internet
	A method of connecting otherwise unrelated computers across standard telephone connections.  Data retrieved or exchanged across such a network.

	Kilobyte (Kb)
	A measure of computer memory size or storage capacity: 1024 bytes, where each byte represents one alphabetic or numeric character.

	Local Database
	The copy of the RED SKY database XE "Database"  which resides on the application user’s own computer

	Login User ID or

Login Name
	The unique identifier which allows a RED SKY user to access, maintain or retrieve a particular set of user, farm and performance data.  The login user ID must be unique throughout the RED SKY database. XE "Database" 

	Megabyte (Mb)
	A measure of computer memory size or storage capacity, equal to 1000Kb

	Server XE "Server"  Database
	The copy of the RED SKY database XE "Database"  which resides on the RED SKY Server XE “Server”  and consolidates and distributes synchronised data from all licensed RED SKY subscribers.

	Server XE "Server"  Pack
	The part of the RED SKY application which resides on the RED SKY Server XE “Server”  and manages the RED SKY Server database and licensing requirements.

	Synchronisation
	The process of updating the RED SKY Server XE “Server”  database XE "Databases Server database"  with data from the local database, XE "Database: Local database"  and receiving updates from the Server to the local database in return.


Bibliography

See the RED SKY website XE "Red Sky Website"  at www.redskyagri.com for a comprehensive list of relevant industry publications and further reading.

Appendices

Appendix A: System Configurations
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Figure 130: RED SKY About Screen - System Information Display

This display illustrates the properties of the local system supporting the RED SKY Client Pack.
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The Status Bar





The Active Window has a (beside it on the Windows Menu





The bright coloured banner shows which window is active.





You can double-click an item to edit it.





Click on the column headings to sort on that field





Click on the NEW button to create a new Farmer/Client





Select the Farmer/Client you want to edit by moving the mouse pointer over it and clicking the left mouse button.  The coloured bar shows which one will be edited.





Click the Edit button to edit the Farmer/Client you’ve selected





Click on the Retrieve button to start the Retrieve dialog…





Click OK to continue…





Click the New button to create a new farm definition





Click the Edit Area button to set production areas





Click the Accept button to set your chosen activities and areas…





Production activity types





…and click the OK button to complete your Farm definition





Select the farm you want to edit, and click the Edit button





Click the New button…








Click the OK button to create the new group





Click the Edit button to amend selected group details





Click here to join a group





Select the group to join….





…and click the <Add button





The farm is shown as requesting to join but not yet accepted in the groups listed





…click the Remove button…





Highlight the Join Request to be removed….





…click OK to complete the remove request








Request to join removed….








…then click OK to accept the addition.





….click the <Add button to add the applicant to your group…





Select the requesting farm name and…





The applicant is added to the group…





And the farm is now shown as accepted in the group





Click the Farmer/Client Gets Reports checkbox to turn Group reporting on and off for that member





Select the member to be removed…





…and click the Remove> button





The member is now removed from the group…





…and now shows as not accepted again in Farm Join Groups





…and this is the active section 





These are the Section Tabs…





Sub Category tabs are YELLOW - this is the active Sub Category 





Category Tabs are ORANGE - this is the active Category





Section Tabs are RED - this is the active Section 





This area is the Data Grid





Place the mouse pointer on the column boundary and click and drag to change the column width





Use the Scroll Bar to move up and down through the data grid rows





This is the Tool Tip area





Dynamic tool tips appear when you float the cursor over a field heading





These are the Frame Controls





The Finished Checkbox…





The Finished box is checked and the datasheet is ticked off





The Lock Status Flag- Unlocked





The Lock Button…





…becomes the Unlock Button when the datasheet is locked





The Lock Status Flag- Locked!





The Set Password Button





The Password Box





Calculation Status information





The Calculate Button





The Print Button…





The Comparison button…





The Close button…





Click the New button to create a new Year





Enter the year details and click Save to create it





The new year is created…





…click on the Edit button to carry on entering the year data.





Work through the Sub Categories from top to bottom





Work across the Sections and Categories from left to right….





…and the Category Tab is struck through to show it is finished too.





All the sub categories are finished and checked off...





Click here to print the report out





Use the Format Controls to change the appearance of your report





Click here to change the Printer Setup





Only the current year data is normally displayed in the datasheet….





…click the Comparison button to select years for Year-on-Year comparison





Select the comparison year and click the Add> button





…Click the OK button to display it





The Comparison year is selected, so…





Comparison year is now displayed alongside the current year data





Click on the Copy button to create a copy of the selected year…





… and click the Copy button to continue





… the copy year is successfully created





Click on the Rollover button to close a year off…





…and click this Rollover button to confirm





… optionally scale the area and/or stock levels, and click OK to complete the rollover operation.





… the rollover year is successfully created








Select the Year you want to delete….





..and click the Delete button to remove it





Click the Delete button to confirm or Cancel to abandon the delete operation





Click Yes to complete the delete operation or No to abandon it





Select the Farm you want to delete…





…and click the Delete button





…and click the Delete button





Select the Farmer/Client  you want to delete…





…and click the Delete button





Select the Group you want to delete…





Click the Synchronise button to launch the Synchronisation process





Tick here to purchase a user license and…





Click OK to continue...





Tick here to synchronise a year and…





Click OK to continue...





Database Compression option checkbox
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